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1. ΔΙ΢ΑΓΩΓΗ 
 
 

1.1 Βιομησανικόρ ΢σεδιαζμόρ 

Σηα ηέιε ηνπ 19νπ αηψλα κε ηνλ θαηακεξηζκφ ηεο εξγαζίαο ζηελ βηνκεραλία, 
δεκηνπξγήζεθε ν βηνκεραληθφο ζρεδηαζκφο (Industrial Design ή Product Design). 

Ωο φξνο “Βηνκεραληθφο Σρεδηαζκφο” νξίδεηαη δεκηνπξγία θαη εμέιημε ηδεψλ θαη 
ραξαθηεξηζηηθψλ κε ζηφρν ηελ βειηίσζε ηνπ ηξφπνπ ιεηηνπξγίαο, ηελ αμία θαη ηελ 
αηζζεηηθή εκθάληζε ησλ πξντφλησλ θαη ζπζηεκάησλ πξντφλησλ, κε ζθνπφ ηελ κέγηζηε 
σθέιεηα ηφζν ηνπ ρξήζηε φζν θαη ηνπ θαηαζθεπαζηή. 

“Ο ζρεδηαζκφο (πξντφλησλ) είλαη κηα δεκηνπξγηθή δνπιεηά πνπ ζθνπφ ηνπ έρεη λα νξίζεη 
ηηο δηάθνξεο πνηφηεηεο ησλ πξντφλησλ ή ζπζηεκάησλ πξντφλησλ. Ο ζρεδηαζκφο ελφο 
πξντφληνο είλαη έλαο παξάγνληαο πνπ δίλεη ζηελ ηερλνινγία έλα “αλζξψπηλν” πξφζσπν 
έηζη ψζηε λα γίλεη ειθπζηηθή ζε απηφλ πνπ ηελ ρξεζηκνπνηήζεη. 

Με ηνλ φξν «Design» ελλννχκε ηε ζχιιεςε θαη αλάπηπμε κηαο ηδέαο. 
Σπγθεθξηκελνπνηείηαη ζε κηα θάζε ζρεδηαζκνχ θαη νινθιεξψλεηαη ζε κηα 
πξνζαλαηνιηζκέλε κε ηηο αλάγθεο ησλ αλζξψπσλ ιχζε ελφο δεδνκέλνπ πξνβιήκαηνο. 

Ο νξηζκφο πνπ δηαηππψζεθε ην 1961 απφ ηνλ Tomas Maldonado γηα ηνλ «Βηνκεραληθφ 
Σρεδηαζκφ» είλαη σο κηα ζρεδηαζηηθή δξαζηεξηφηεηα πνπ ζπλίζηαηαη ζην λα νξίζεη ηηο 
κνξθνινγηθέο ηδηφηεηεο ησλ αληηθεηκέλσλ πνπ παξάγνληαη βηνκεραληθά. Ωο 
κνξθνινγηθέο ηδηφηεηεο δελ αλαθεξφκαζηε κφλν ζηα εμσηεξηθά ραξαθηεξηζηηθά ελφο 
αληηθεηκέλνπ, αιιά θπξίσο ζηηο ιεηηνπξγηθέο θαη δνκηθέο ζρέζεηο πνπ ην θαζνξίδνπλ ζαλ 
κηα ζαθή ελφηεηα, ηφζν απφ ηελ πιεπξά ηνπ θαηαζθεπαζηή φζν θαη απφ ηελ αληίζηνηρε 
ηνπ ρξήζηε. Έηζη θαζνξίδεηαη αθξηβψο θαη ν ξφινο ηνπ «Βηνκεραληθνχ Σρεδηαζκνχ» 
κέζα απφ ηηο αλάγθεο ηεο παξαγσγήο θαη ηηο απαηηήζεηο ηεο θαηαλάισζεο. 
Έλαο απφ ηνπο πην επηηπρεκέλνπο designers, ν Erich Slanv, ιεεη : «θαιφ design» είλαη ν 
βέιηηζηνο ζπκβηβαζκφο φισλ ησλ θαζνξηζηηθψλ παξαγφλησλ ηεο παξαγσγήο, 
ιακβάλνληαο ππφςε ιεηηνπξγηθέο, εξγνλνκηθέο θαη ηππηθά αηζζεηηθέο, απφςεηο, νη 
νπνίεο λα αληαπνθξίλνληαη ζην πλεχκα ηεο επνρήο ηνπο. Design είλαη ν ζρεδηαζκφο 
πξντφλησλ, πνπ πξννξίδνληαη γηα βηνκεραληθή παξαγσγή θαη καδηθή θαηαλάισζε. Απηφ 
πξνυπνζέηεη ηελ νξγάλσζε ηεο δνκήο ηνπ, ηε δηακφξθσζε ηεο ιεηηνπξγηθφηεηάο ηνπ, 
αιιά θαη ηε δεκηνπξγία ηεο αηζζεηηθήο ηνπο εκθάληζεο, κε ζθνπφ ηελ απνηειεζκαηηθή 
παξαγσγή θαη δηάζεζε, ηελ εκπνξηθή επηηπρία θαη ηελ αληαγσληζηηθφηεηα ησλ 
πξντφλησλ. Τν design επεξεάδεηαη απφ ηελ νηθνλνκία θαη ην εκπφξην, αιιά θαη απφ ηελ 
ηέρλε, κε ηελ νπνία αθνινπζεί παξάιιειε πνξεία θαη απνηειεί βαζηθφ ζηνηρείν ησλ 
αληηθεηκέλσλ απηψλ. 
O βηνκεραληθφο ζρεδηαζκφο απνηειεί ζήκεξα κηα αλαγθαία αληηκεηψπηζε ηνπ 
πξνβιήκαηνο ηεο παξαγσγηθήο θαη θαηαζθεπαζηηθήο δηαδηθαζίαο. Οη λέεο κνξθέο 
θαηαλάισζεο, ζπλδπαζκέλεο κε ηελ άλνδν ηνπ βηνηηθνχ επηπέδνπ θαη ηηο ζπλερψο 
απμαλφκελεο απαηηήζεηο ηεο αγνξάο, ζπλέβαιαλ απνθαζηζηηθά. Απνηέιεζκα ήηαλ ε 
πξνψζεζε ηεο ηερλνινγίαο, αξρηθά ζαλ ζρεδηαζκφο κε H/Y (CAD) θαη ζηε ζπλέρεηα ζαλ 
παξαγσγή H/Y κε (CAM). 

http://el.wikipedia.org/wiki/19%CE%BF%CF%82_%CE%B1%CE%B9%CF%8E%CE%BD%CE%B1%CF%82
http://el.wikipedia.org/wiki/%CE%92%CE%B9%CE%BF%CE%BC%CE%B7%CF%87%CE%B1%CE%BD%CE%AF%CE%B1
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Σηελ Διιάδα παξ φηη αξθεηνί Έιιελεο έρνπλ γίλεη δηεζλψο γλσζηνί βηνκεραληθνί 
ζρεδηαζηέο φπσο ν Ηζζηγφλεο ζηελ Βξεηαλία θαη ν Εσγξάθνο ζηεο ΖΠΑ ην επάγγεικα 
είλαη ζρεηηθά άγλσζην ζην επξχηεξν θνηλφ. Υπήξραλ θαη αξθεηέο ηδησηηθέο 
δξαζηεξηφηεηεο γηα κηα εγθαηάζηαζε θαη έλαλ δεκφζην δηάινγν ζηνλ βηνκεραληθφ 
ζρεδηαζκφ. Τν 1961 άλνημε ην Athens Design Centre κε ζηφρν λα βειηηψζεη κέζν ηνπ 
ζρεδηαζκνχ ηελ αληαγσληζηηθφηεηα ηεο Διιεληθήο νηθνλνκίαο. Οη ηδξπηέο ήηαλ 
ζρεδηαζηέο, επηζηήκνλεο θαη επηρεηξεκαηίεο. Τν 1963 ην ADC θιείλεη. 

 
 
 

1.2 ΢ςζηήμαηα CAD - Ιζηοπική αναδπομή 

Ζ ηζηνξηθή εμέιημε ησλ ζπζηεκάησλ CAD είλαη φκνηα κε απηή ησλ ειεθηξνληθψλ 
ππνινγηζηψλ, αλ θαη ε αμηνπνίεζε ησλ ειεθηξνληθψλ ππνινγηζηψλ ζηνλ ρψξν απηφ δελ 
έγηλε απφ ηελ πξψηε ζηηγκή. Δγηλε κφιηο ε ηερλνινγία ην επέηξεςε. Απηφ νθείιεηαη ζην 
νηη ζα έπξεπε πξψηα λα ππάξμνπλ ζεκαληηθέο βειηηψζεηο ζηα γξαθηθά θαη ζηηο 
κεζφδνπο ςεθηαθήο απεηθφληζεο θαη απνζήθεπζεο ησλ δεδνκέλσλ. Τν ζεκαληηθφηεξν 
ζε απηή ηελ πεξίνδν δελ είλαη ε γξαθηθή απεηθφληζε αιιά ν ηξφπνο απνζήθεπζεο θαη 
δηαρείξηζήο ηεο πιεξνθνξίαο. Σηελ πξαγκαηηθφηεηα έλα ζχζηεκα CAD είλαη έλα 
ζχζηεκα δηαρείξηζεο κίαο γξαθηθήο βάζεο δεδνκέλσλ. 

Ωο πξσηνπφξνο ηεο ηερλνινγίαο CAD ζεσξείηαη ν Dr. Hanratty ν νπνίνο ζε ζπλεξγαζία 
κε ηελ General Motors ην 1957 ζρεδίαζε ην πξψην ζχζηεκα ακθίδξνκσλ γξαθηθψλ 
θαηεξγαζίαο ην DAC (Design Automated by Computer). Τν 1971 ίδξπζε ηελ MCS 
(Manufacturing and Consulting Services), εηαηξία πνπ ππνζηήξηδε κε θψδηθα εηαηξίεο 
φπσο νη McDonnell Douglas (Unigraphics), Computervision (CADDS), AUTOTROL and 
Control Data. Αλαιπηέο εθηηκνχλ φηη ην 70% φισλ ησλ 3D  MCAD/CAM ζχγρξνλσλ 
ζπζηεκάησλ έρνπλ ηηο ξίδεο ηνπο ζηνλ αξρηθφ θψδηθα ηεο MCS. Απηφο πνπ ηεθκεξίσζε 
ηελ ηερληθή CAD είλαη ν Ian Sutherland ηνπ ΜΗΤ, κε ηελ εηζήγεζε ζρεηηθνχ πξσηφηππνπ 
ζπζηήκαηνο ηνπ Sketch-Pad ην 1961. Μαδί κε ηνλ Dr. David Evans δεκηνχξγεζαλ ηελ 
Evans & Sutherland ην 1968. 

Κχξην κέιεκα ηνπ CAD ηελ πεξίνδν ηνπ 1970 ήηαλ ην δηζδηάζηαην ζρέδην(2D). Απιέο 
γξακκέο θαη θχθινη ζε κηα νζφλε ππνινγηζηή δεκηνπξγνχζαλ δηεξγαζίεο θνπήο κε 
ρξήζε macro/programming interface. Σε απηήλ ηελ πεξίνδν νη ρξήζηεο έπξεπε λα είλαη 
θαινί ζρεδηαζηέο αιιά θαη θαινί πξνγξακκαηηζηέο. Αξθεηέο ζπζθεπέο θαη εθαξκνγέο 
πνπ έθαλαλ ηελ εκθάληζε ηνπο απηήλ ηελ πεξίνδν ήηαλ απφ ηελ United Computing, 
Intergraph θαη ηελ IBM. Ήηαλ εθαξκνγέο κηθξήο αθξίβεηαο ιφγν ηεο πεξηνξηζκέλεο 
δχλακεο ησλ ππνινγηζηψλ. 

 
 
 
Σηηο αξρέο ηεο δεθαεηίαο ηνπ 1980, αθνινπζψληαο ηελ εμέιημε ησλ ππνινγηζηψλ, 
παξνπζηάζηεθαλ αξθεηέο δπλαηέο εθαξκνγέο. Τν 1981 ε Unigraphics παξνπζίαζε ην 

http://el.wikipedia.org/wiki/%CE%86%CE%BB%CE%B5%CE%BA_%CE%99%CF%83%CF%83%CE%B9%CE%B3%CF%8C%CE%BD%CE%B7%CF%82
http://el.wikipedia.org/wiki/%CE%9D%CE%AF%CE%BA%CE%BF%CF%82_%CE%96%CF%89%CE%B3%CF%81%CE%AC%CF%86%CE%BF%CF%82
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πξψην solid modeling ζχζηεκα, ην Uni-Solids. Σηα κέζα απηήο ηεο δεθαεηίαο 
παξνπζηάζηεθαλ ηα πξψηα feature-based parametric solid modeling ζπζηήκαηα. 

Δπίζεο έρνπκε ηελ αλάπηπμε ηνπ PC θαη ηελ ίδξπζε ηεο Autodesk. Ο John Walker θαη νη 
ζπλεξγάηεο ηνπ ίδξπζαλ ηελ Autodesk ην 1982. Αλέπηπμαλ πέληε δηαθνξεηηθέο 
απηφκαηεο εθαξκνγέο αλακέλνληαο φηη κία απφ φιεο ζα επηηχρεη εκπνξηθά. Ζηαλ έλα 2D 
κηθξψλ δπλαηνηήησλ πξφγξακκα, ην Autocad. Απνηέιεζκα ήηαλ έλα ηξνκαθηηθφ δίθηπν 
κεηαπσιεηψλ πνπ παξνπζίαδαλ ην λέν πξντφλ ρσξίο λα πξέπεη λα ηνπο πιεξψλεη ε 
Autodesk. 

Τν CADKEY εζηίαζε ζην 3D ζρεδηαζκφ Τν Pro/ENGINEER ην 1988 παξνπζίαζε ην πην 
αμηφπηζην 3D solid modeling ζχζηεκα. Σε απάληεζε ην Unigraphics ηελ ίδηα ρξνληά 
μεθίλεζε ηελ εκπνξηθή πξνψζεζε ηνπ Parasolid Kernel σο απηφλνκνπ πξντφληνο. 

Τν 1990 ε Spatial Technologies παξνπζίαζε ην ACIS, κία εκπνξηθή solid modeling 
κεραλή κε δπλαηφηεηα λα γίλεηαη πξνζβάζηκε θαη λα ρξεζηκνπνηείηαη απφ πνιιά 
δηαθνξεηηθά πεξηβάιινληα φπσο modeling, assembly, manufacturing θ.α. ηαπηφρξνλα. 
Ζ ηερλνινγία CAD βξέζεθε κπξνζηά απφ ηελ εμέιημε ησλ εκπνξηθψλ ππνινγηζηψλ ηεο 
Microsoft. Τν αξλεηηθφ απηψλ ησλ ζπζηεκάησλ ήηαλ ζηελ πξνζαξκνγή επέιηθησλ 
γξαθηθψλ ζπζηεκάησλ θαη ζηε ρξήζε ελφο θηιηθνχ ζπζηήκαηνο γξαθηθψλ επηθνηλσλίαο 
κε ηνλ ρξήζηε (GUI). 

Με ηελ έθξεμε ησλ πξνζσπηθψλ ππνινγηζηψλ (PCs), ζηε δεθαεηία ηνπ 1990, θαη ηελ 
πηνζέηεζε ησλ Windows ζαλ ιεηηνπξγηθφ ζχζηεκα ζε απηά, ε αμηνπνίεζε θαη 
εθκεηάιιεπζε ησλ CAD ζπζηεκάησλ έγηλε πιένλ δπλαηή απφ έλα επξχ θάζκα 
ρξεζηψλ. Τν γεγνλφο χπαξμεο CAD πξνγξακκάησλ αθφκε θαη ζηα πξψηα ζηάδηα 
αλάπηπμεο ησλ PCs, ζηα κέζα ηεο δεθαεηίαο ηνπ „80, ηφηε πνπ ην DOS θπξηαξρνχζε 
ζαλ ιεηηνπξγηθφ ζχζηεκα, απνδεηθλχεη ηελ κεγάιε αλάγθε ηεο αγνξάο γηα ηέηνηνπ είδνπο 
ζπζηήκαηα. 

Τα πξνβιήκαηα ηα νπνία έπξεπε λα επηιχζνπλ νη θαηαζθεπαζηέο CAD πξνγξακκάησλ 
ζην DOS αθνξνχζαλ ηελ αλάπηπμε ελφο γξαθηθνχ ζπζηήκαηνο επηθνηλσλίαο ηνπ 
πξνγξάκκαηνο κε ηνλ ρξήζηε γηα ηελ άκεζε θαη γξήγνξε επηινγή ησλ εληνιψλ 
ζρεδίαζεο. Δπίζεο έπξεπε λα δεκηνπξγεζνχλ αμηφπηζηα θαη ηαρχηεηα ππνζπηήκαηα 
απεηθφληζεο γξαθηθψλ (Display Drivers) γηα ηελ απεηθφληζε ηνπ ζρεδίνπ ζηελ νζφλε. 
Δλα άιιν βαζηθφ ζέκα ήηαλ ε απνζήθεπζε ησλ ζρεδίσλ, ηα αξρεία ησλ νπνίσλ είραλ 
κεγάιν κέγεζνο γηα ηα ηφηε δεδνκέλα. Τέινο ζεκαληηθφ ζέκα ήηαλ ε δηάζεζε 
πξνγξακκάησλ-νδεγψλ πεξηθεξεηαθψλ ζπζθεπψλ εθηχπσζεο ησλ ζρεδίσλ (drivers). 
Τελ επνρή εθείλε, ην θάζε CAD πξφγξακκα ζπλνδεχνληαλ απφ έλα πιήζνο βνεζεηηθψλ 
πξνγξακκάησλ γηα ηελ δηαρείξηζε θαξηψλ νζφλεο, printers, plotters θαη πεξηθεξεηαθψλ 
επηινγήο εληνιψλ mouse, digitisers, θηι. Με ηελ εηζαγσγή ησλ Windows θαη ηελ 
δηάζεζε ησλ εξγαζηαθψλ πφξσλ (resources) ηνπο ζηα πξνγξάκκαηα πνπ ηξέρνπλ ζε 
απηά, ιχζεθαλ πνιιά απφ ηα πξνβιήκαηα πνπ αληηκεηψπηδαλ νη θαηαζθεπαζηέο CAD 
πξνγξακκάησλ, ηφζν ζε επίπεδν drivers, φζν θαη ζε ζέκαηα δηαρείξηζεο κλήκεο θαη 
απνζήθεπζεο δεδνκέλσλ.Ζ βειηίσζε θαη αλάπηπμε CAD ζπζηεκάησλ ζηνλ ρψξν ησλ 
PCs ππήξμε ηφζν ξαγδαία φζν θαη ε εμέιημε ησλ ίδησλ ησλ PCs. Δηδηθά κε ηα Windows 
95 θαη θπξίσο κε ηα Windows NT, ηα νπνία ζεσξνχληαη ν παξάδεηζνο ησλ CAD 
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πξνγξακκάησλ, ζε ζπλδπαζκφ κε ηελ θπθινθνξία θαηλνχξγησλ ηζρπξψλ επεμεξγαζηψλ 
(Pentium IIΗ), ην κέιινλ ηνπ CAD πξνγξακκάησλ πξνδηαγξάθεηαη ηδηαίηεξα ιακπξφ. 
Δπίζεο κηα αιιε ηερλνινγία, ε OLE (Object Linking and Embedding) έθαλε ηα Windows 
λα επηηξέπνπλ ζε εθαξκνγέο πνπ ηξέρνπλ ζε απηά λα αληαιιάζζνπλ δεδνκέλα θαη λα 
ελζσκαηψλνπλ έγγξαθα ηα νπνία έρνπλ δεκηνπξγεζεί κε άιιεο εθαξκνγέο. Δηζη 
κπνξνχκε κέζα ζε έλα ζρέδην λα ελζσκαηψζνπκε έλα νιφθιεξν θείκελν πνπ έρνπκε 
γξάςεη κε έλα επεμεξγαζηή θεηκέλνπ, έλα ινγηζηηθφ θχιιν πνπ έρνπκε δεκηνπξγήζεη κε 
θάπνην αληίζηνηρν πξφγξακκα, ή κία εηθφλα ηελ νπνία δεκηνπξγήζακε κε κία άιιε 
εθαξκνγή. 

Σηηο κέξεο καο ηα CAD ζπζηήκαηα βειηηψζεθαλ ηφζν πνιχ ψζηε φια ζρεδφλ ηα 
ζπζηήκαηα δηαζέηνπλ έλαλ αξθεηά κεγάιν αξηζκφ φκνησλ εληνιψλ 3D modeling, 
(extrude, revolve, sweep, loft, chamfer, blend-fillet, shell, θ.α.) Όια επίζεο ηα ηζρπξά θαη 
κέζα ζπζηήκαηα CAD δηαζέηνπλ εθαξκνγέο θαη κεηαθξαζηέο ζπλαιιαγήο δεδνκέλσλ 
φπσο IGES, STEP, STL, ACIS, Parasolid, DXF, DWG σο δεδνκέλα εξγαιεία. Όια ηα 
CAD ρξεζηκνπνηνχλ ινγηθή ραξαθηεξηζηηθψλ θαη παξακέηξσλ ζε έλα ζχζηεκα 
ζρεδίαζεο Feature/ Assembly tree. Αιιά θαη ηα modules ησλ ινγηζκηθψλ απηψλ ζε 
γεληθέο γξακκέο ζπγθιίλνπλ εθφζνλ έγηλε ή γίλεηαη γλσζηή ζηαδηαθά ε ηερλνγλσζία ηεο 
δεκηνπξγίαο ηνπο. Δθηφο δειαδή απφ ηα γλσζηά modeling, drafting, assembly, FEA, 
εκθαλίδνληαη θαη ηα Sheet metal, mold and die, die mold, packaging, nesting, routing 
and piping. Όια ζρεδφλ ηα ζχρξνλα ζπζηήκαηα ρξεζηκνπνηνχλ θαη πεξηιακβάλνπλ 
ζηελ ζηάληαξ έθδνζή ηνπο API (Application Programming Interfaces) κε δπλαηφηεηεο 
πνιχ δπλαηψλ add-on πξνγξακκάησλ, εμνκεηψζεσλ, θσηνξεαιηζκφ θαη παξνπζηάζεηο 
θίλεζεο. Με δεδνκέλε απηή ηελ παξαιιειία φισλ ζρεδφλ ησλ γλσζηψλ πξνγξακκάησλ 
ζην επίπεδν βηνκεραληψλ-εηαηξηψλ δελ ππάξρεη ην πξφβιεκα ηεο δπζβάζηαρηεο 
εθπαίδεπζεο ησλ ρξεζηψλ CAD ζπζηεκάησλ εθφζνλ ν θάζε θαιφο ρξήζηεο CAD είλαη 
ζε ζέζε λα ρξεζηκνπνηήζεη φπνην ζχζηεκα ηνπ επηβάιεη ε θάζε εηαηξία ζηελ νπνία 
θαιείηαη λα εξγαζηεί.Τα ζχγρξνλα ζπζηήκαηα, ηδηαίηεξα φζα απεπζχλνληαη ζε 
κεραλνινγηθά πξντφληα απνηεινχλ ηξηζδηάζηαηα ζπζηήκαηα ηα νπνία θαηαθηνχλ θαη 
ηνπο ππφινηπνπο ηνκείο. 

 

1.3 Μονηέλα επιθανειών 

Ζ ηξηζδηάζηαηε κνληεινπνίεζε κπνξεί λα απνηειεί κνληεινπνίεζε Αθκψλ, Δπηθαλεηψλ 
ή Σηεξεψλ. Τα πεξηζζφηεξα κεζαίαο θιίκαθαο ζπζηήκαηα CAD ηνπ ηνκέα 
κεραλνινγηθψλ πξντφλησλ είλαη Σπζηήκαηα Μνληεινπνίεζεο Σηεξεψλ Όγθσλ βάζεη 
Παξακέηξσλ θαη Φαξαθηεξηζηηθψλ. 

 

1.3.1 Μονηελοποίηζη ακμών 

Ζ κνληεινπνίεζε αθκψλ (Wireframe Model) ήηαλ ε πξψηε απφπεηξα αλαπαξάζηαζεο 
ησλ ηξηψλ δηαζηάζεσλ ελφο αληηθεηκέλνπ. Απνηεινχληαη κφλν απφ θνξπθέο θαη αθκέο. 
Οη θνξπθέο είλαη ζην ρψξν θαη νη αθκέο είλαη επζχγξακκα ηκήκαηα, θχθινη, ηφμα ή 
θσληθέο ηνκέο θαη ζχλζεηεο θακπχιεο ειεχζεξεο κνξθήο, πνπ νξίδνληαη κεηαμχ δχν 
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θνξπθψλ. Απνηειεί ηελ πην απιή κνξθή απεηθφληζεο ηνπ ρψξνπ. Πξνέξρεηαη απφ ην 
δηζδηάζηαην κνληέιν κε ηελ πξνζζήθε ηεο ηξίηεο δηάζηαζεο θαη ηελ αλάπηπμε 
εξγαιείσλ δεκηνπξγίαο, επεμεξγαζίαο θαη πξνβνιήο ηεο γεσκεηξίαο ζηελ νζφλε. Απφ 
ην κνληέιν αθκψλ κπνξεί λα γίλεη απηφκαηε παξάγσγε φισλ ησλ φςεσλ ηνπ 
αληηθεηκέλνπ, ρσξίο φκσο λα είλαη δπλαηή ε εκθάληζε ηεο εζσηεξηθήο δηακφξθσζεο ηνπ 
αληηθείκελνπ ζε ηνκέο. Κχξην κεηνλέθηεκα είλαη φηη ηα δεδνκέλα νξηζκνχ ησλ δηάθνξσλ 
γεσκεηξηθψλ ζηνηρείσλ είλαη ζπλήζσο πνιχ ζηνηρεηψδε. Τα δεδνκέλα απηά αθνξνχλ 
γξαθηθά θαη δεδνκέλα ηνπνινγίαο φπνπ γξαθηθά είλαη νη ζπληεηαγκέλεο ησλ θνξπθψλ 
θαη νη εμηζψζεηο ησλ αθκψλ θαη ίζσο ησλ εδξάλσλ κε ηηο αθκέο αλαπαξάζηαζε 
απνδείρζεθε αλεπαξθήο εθφζνλ παξνπζίαδε πνιιά κεηνλεθηήκαηα απφ άπνςε 
αθξηβείαο, απεηθφληζεο, θιπ. Ζ ζπγθεθξηκέλε ηερληθή απνηειεί πιένλ ελδηάκεζν ζηάδην 
γηα ηελ θαηαζθεπή ελφο κνληέινπ επηθαλεηψλ ή ζηεξεψλ φγθσλ. Δπίζεο ν ρξήζηεο έρεη 
ζηε δηάζεζή ηνπ µηα ζεηξά απφ εξγαιεία θαη ελαιιαθηηθέο δπλαηφηεηεο γηα ηε δεµηνπξγία 
θαη επηινγή ησλ γεσµεηξηθψλ ζηνηρείσλ, ηελ εθηέιεζε ησλ µεηαζρεµαηηζµψλ θαη ηνλ 
νξηζµφ βνεζεµάησλ ζρεδίαζεο, φπσο: 

 Γεσµεηξηθά ζηνηρεία. Μπνξεί λα ζρεδηάζεη γξαµµέο, θχθινπο, ηφμα, θαµπχιεο 
ειεχζεξεο µνξθήο, φπσο Splines, Bezier, θαη B-Splines, θιπ.  

 Με γεσµεηξηθά ζηνηρεία, φπσο θείµελν θαη ζχµβνια.  

 Πξφζβαζε ζε βηβιηνζήθεο γξαθηθψλ, γηα ζπλήζε εμαξηήµαηα ζηνηρείσλ 
µεραλψλ θαη µεραληζµψλ, φπσο, θνριίεο, ζπεηξψµαηα, έδξαλα, θιπ  
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 Βνεζεηηθά εξγαιεία ζρεδίαζεο, επίπεδα (layers) ζηα νπνία µπνξεί λα θαηαλείµεη 
ηα ζηνηρεία ηεο ζρεδίαζεο, πιέγµα (grid) πνπ ρξεζηµνπνηείηαη σο βνήζεµα ζηελ 
ζρεδίαζε, θιείδσµα (snap) γηα ηελ ζρεδίαζε ζε νξηζµέλα µφλν πξνθαζνξηζµέλα 
ζεµεία, θιπ.  

 Δπίπεδα ζρεδίαζεο γηα ηελ απφδνζε ζηνηρείσλ ζε επίπεδα εθηφο ηνπ αξρηθνχ 
θαξηεζηαλνχ ζπζηήµαηνο.  

  Μεηαζρεµαηηζµνχο γηα ηελ αλαπαξαγσγή ζηνηρείσλ, µεηαθνξά, αληηγξαθή, 
πεξηζηξνθή, θαηνπηξηζµφ, µεγέζπλζε.  

 Δξγαιεία δηφξζσζεο, φπσο απνθνπή-επέθηαζε ζε γσλίεο, µεηαμχ ησλ 
δηαθφξσλ γεσµεηξηθψλ ζηνηρείσλ, παξαγσγή λένπ γεσµεηξηθνχ ζηνηρείνπ µε 
αληηζηάζµηζε.  

 Απφδνζε δηαζηάζεσλ ζην ζρέδην. Ζ µέηξεζε ηεο δηάζηαζεο γίλεηαη απηφµαηα 
απφ ηε βάζε δεδνµέλσλ ηνπ µνληέινπ θαη ην ζχζηεµα έρεη ελζσµαησµέλνπο 
ηνπο θαλφλεο ζρεδίαζεο γηα δηαζηάζεηο.  

 Δξγαιεία εζηίαζεο ζε πεξηνρέο ηνπ ζρεδίνπ, γηα ηελ απφδνζε ιεπηνµεξεηψλ θαη 
µεηαηφπηζεο ζρεδίνπ. 
 
 

1.3.2. Μονηελοποίηζη επιθανειών 

Έλα κνληέιν επηθαλεηψλ (Surface Models) κνληεινπνηεί ηελ εμσηεξηθή επηθάλεηα ηνπ 
εμαξηήκαηνο. Τα πξψηα ζπζηήκαηα βαζίδνληαλ ζε θακπχιεο Fergusson θαη Bezier, ελψ 
ηα ζχγρξνλα ρξεζηκνπνηνχλ θπξίσο NURBS, πνπ έρνπλ ηε δπλαηφηεηα 
κνληεινπνίεζεο φισλ ζρεδφλ ησλ βηνκεραληθψλ εμαξηεκάησλ, φπσο επηθάλεηεο 
αεξνζθαθψλ θαη απηνθηλήησλ (επηθάλεηεο Κιάζεο A), λαππήγεζεο πινίσλ, πιαζηηθά 
εμαξηήκαηα θαη πιηθά ζπζθεπαζίαο γεληθά, κεηαιιηθά εμαξηήκαηα, ππνδήκαηα θιπ. 
Απνηεινχλ ηα θαηαιιειφηεξα ζπζηήκαηα γηα ηελ αλαπαξάζηαζε βηνκεραληθψλ 
εμαξηεκάησλ. Δπηηξέπεη ηελ παξαγσγή επηθαλεηψλ νη νπνίεο δελ κπνξνχλ πξνο ην 
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παξφλ λα πξνθχςνπλ κε ηε ρξήζε ζπζηεκάησλ κνληεινπνίεζεο ζηεξεψλ φγθσλ. 
Γεκηνπξγνχληαη απφ γεληθέο ζαξψζεηο θαηά κήθνο θακππιψλ, ζρήκαηα αλαινγηθήο 
αλάπηπμεο κε ηε ρξήζε ζσκάησλ πξνεξρνκέλσλ απφ εμψζεζε 1, 2 ή 3 νδεγψλ, 
ζηξνγγπιέκαηα κε θπθιηθή ή θσληθή δηαηνκή θαη επηθάλεηεο νη νπνίεο γεθπξψλνπλ 
νκαιά ηα θελά κεηαμχ δχν ή πεξηζζφηεξσλ άιισλ ζσκάησλ. Τα πεξηζζφηεξα έρνπλ ηε 
δπλαηφηεηα δεκηνπξγίαο ζρεκάησλ πνπ νξίδνληαη κέζσ ελφο πιέγκαηνο απφ 
θακπχιεο/ζεκεία ή κέζσ ελφο ζχλλεθνπ απφ ζεκεία, κία ηερληθή θαηάιιειε γηα 
εξγαζίεο αλάζηξνθεο κεραληθήο. Ζ επεμεξγαζία ησλ κνληέισλ απηψλ γίλεηαη κε ηελ 
ηξνπνπνίεζε ησλ θαζνξηζκέλσλ θακππιψλ, κε ηελ αιιαγή ησλ ηηκψλ ησλ παξακέηξσλ 
ή κέζσ ηεο ρξήζεο γξαθηθψλ λφκσλ πνπ ειέγρνπλ ηα δεκηνπξγεκέλα ζρήκαηα. Τα 
ζπζηήκαηα πεξηιακβάλνπλ επίζεο εξγαιεία γηα ηελ αμηνιφγεζε ηνπ ζρήκαηνο, ηνπ 
κεγέζνπο θαη ηεο θακππιφηεηαο ζχλζεησλ κνληέισλ. Οη επηθάλεηεο πνπ δεκηνπξγνχληαη 
κέζσ ππνκνλάδαο επηθαλεηψλ ειεχζεξεο κνξθήο κπνξνχλ λα εληαρζνχλ ζε έλα 
κνληέιν ζηεξεψλ φγθσλ. Πιενλεθηήκαηα έλαληη ησλ κνληέισλ αθκψλ είλαη: 

 Πην αθξηβή αλαπαξάζηαζε ηεο ηειηθήο κνξθήο ηνπ αληηθεηκέλνπ. 

 Γπλαηφηεηα κνληεινπνίεζεο ζρεδφλ θάζε αληηθεηκέλνπ, φζν πνιχπινθν θαη αλ 
είλαη. 

 Γπλαηφηεηα απφθξπςεο κε νξαηψλ αθκψλ θαη επηθαλεηψλ απηφκαηα. 

 Σθίαζε θαη θσηνξεαιηζκφ ησλ κνληέισλ γηα θαιχηεξε παξνπζίαζε. 

 Γεκηνπξγία θνπηηθνχ εξγαιείνπ γηα πξνγξακκαηηζκφ αξηζκεηηθνχ ειέγρνπ 
νπνηαδήπνηε εξγαιεηνκεραλήο, ην νπνίν είλαη θαη ην πην ηζρπξφ πιενλέθηεκα. 

 Γεκηνπξγία πιέγκαηνο πεπεξαζκέλσλ ζηνηρείσλ γηα αλάιπζε ξνήο, ζεξκηθή 
αλάιπζε, αλάιπζε πιαζηηθψλ, θ.ιπ. 

 Υπνινγηζκφο θπζηθψλ ηδηνηήησλ, φπσο επηθάλεηα, φγθνο, θ.ιπ. 

 Τνκή θαη έιεγρνο παξεκβνιήο αληηθεηκέλσλ. 

 

1.3.3 Παπαμεηπική μονηελοποίηζη με σαπακηηπιζηικά 

Τα ζπζηήκαηα Μνληεινπνίεζεο Σηεξεψλ 
Όγθσλ (Parametric and Feature Based 
Modeling) ζεσξνχληαη φηη πξνζθέξνπλ ηελ 
πην πιήξε αλαπαξάζηαζε ελφο εμαξηήκαηνο. 
Τα πξψηα ζπζηήκαηα βαζίδνληαλ ζηα 
αξρέηππα γηα ηελ αλαπαξάζηαζε ηνπ 
δηαζηήκαηνο, δηακνξθψλνληαο ηα ζπζηήκαηα 
CSG (Constructive solid Modelling). Με ηελ 
παξακεηξηθή ηερλνινγία ν ρξήζηεο απνδίδεη 
παξακέηξνπο γηα ηνλ νξηζκφ ησλ δηαζηάζεσλ, 
ησλ ζρέζεσλ κεηαμχ ησλ παξακέηξσλ θαη 
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ησλ ζρέζεσλ κεηαμχ ησλ εμαξηεκάησλ. Δπνκέλσο, κπνξεί λα νξίζεη έλα εμάξηεκα 
απνδίδνληαο λέεο ηηκέο ζηηο παξακέηξνπο ή λα νξίζεη κία νιφθιεξε νηθνγέλεηα 
εμαξηεκάησλ κέζσ ελφο πίλαθα δηαζηάζεσλ. Με ηελ κνληεινπνίεζε βάζεη 
ραξαθηεξηζηηθψλ ν ρξήζηεο έρεη πξφζβαζε ζε πςειφηεξν επίπεδν έθθξαζεο γηα 
κνληεινπνίεζε ή κπνξεί λα νξίζεη ηα δηθά ηνπ ραξαθηεξηζηηθά. Τα ραξαθηεξηζηηθά απηά 
έρνπλ ελζσκαησκέλν αξηζκφ ηδηνηήησλ ζηηο νπνίεο ζπκπεξηιακβάλνληαη ε κνξθή, νη 
δηαζηάζεηο θαη ε ζέζε. Έλα ζεκαληηθφ ραξαθηεξηζηηθφ ηνπ ζπζηήκαηνο κνληεινπνίεζεο 
ζηεξεψλ φγθσλ βάζεη Παξακέηξσλ θαη Φαξαθηεξηζηηθψλ είλαη νη δπλαηφηεηεο 
ζπλαξκνιφγεζεο πνπ πξνζθέξνπλ. Τα εμαξηήκαηα ζπλδπάδνληαη ή ηνπνζεηνχληαη θαη 
είλαη ζπλεηξκηθά. Οξηζκέλα απφ απηά  επηηξέπνπλ ηελ δεκηνπξγία εμαηξεηηθά κεγάισλ 
δνκψλ πξντφλησλ ηα νπνία κπνξεί λα κνηξάδεηαη κία νκάδα ζρεδηαζκνχ. Γηα ηηο 
ζπλαξκνινγήζεηο απηέο ρξεζηκνπνηνχληαη θάπνηα εηδηθά ζπζηήκαηα πνπ εθηεινχλ 
έιεγρν ηεο θφξησζεο δεδνκέλσλ ψζηε λα αληαπνθξίλνληαη γξήγνξα ζηηο εληνιέο ηνπ 
ρξήζηε. Τα ζπζηήκαηα απηά είλαη θαηάιιεια γηα ηελ ςεθηαθή δηαδηθαζία δεκηνπξγίαο 
ηνπ κνληέινπ ελφο ζρεδίνπ γηα θαηάζηξσζε ζχλζεησλ πξντφλησλ θαη επηηξέπνπλ ην 
γξήγνξν θαζαξηζκφ, ηνλ έιεγρν θαη ηε θσηναπφδνζε ησλ ζθηαζκέλσλ θαη ησλ  θξπθψλ 
γξακκψλ ζέαζεο. Τα πεξηζζφηεξα ζπζηήκαηα ελζσκαηψλνπλ κία ππνκνλάδα γηα 
ζρεδηαζκφ κεηαιιηθψλ θχιισλ, παξέρνληαο ζην ζρεδηαζηή ηε δπλαηφηεηα λα νξίδεη θαη 
λα πξνζνκνηψλεη ηηο αθνινπζίεο θαηαζθεπήο, λα μεδηπιψλεη θαη λα αλαδηπιψλεη ηα 
κνληέια θαη λα παξάγεη αθξηβή δεδνκέλα επίπεδεο ζρεκαηνκνξθήο γηα downstream 
εθαξκνγέο.Τα εμαξηήκαηα πνπ δεκηνπξγνχληαη ζε ζπζηήκαηα κνληεινπνίεζεο ζηεξεψλ 
φγθσλ κπνξνχλ λα κεηαθέξνληαη ζε ζπζηήκαηα πξνζρεδίσλ γηα παξαγσγή ζρεδίσλ. Ζ 
ππνκνλάδα απηή δεκηνπξγεί δηαζηάζεηο πνπ ηαπηίδνληαη κε ην γεσκεηξηθφ κνληέιν 
δηαζθαιίδνληαο ηελ ελεκέξσζή ηνπο ζε θάπνηα αιιαγή ηνπ κνληέινπ κεηψλνληαο έηζη 
ηνλ ρξφλν πνπ απαηηείηαη γηα ηελ ελεκέξσζε ησλ ζρεδίσλ. Οη δπλαηφηεηεο απηφκαηεο 
θαηάζηξσζεο άπνςεο παξέρνπλ γξήγνξε θαηάζηξσζε ζρεδίνπ γηα φιεο ηηο φςεηο, ηηο 
ηνκέο θαη ηηο πξνβνιέο. 

 

 

1.4 Conceptual Design 

Ωο Conceptual Design νξίδνπκε έλα είδνο ηέρλεο ην νπνίν δίλεη πξνηεξαηφηεηα ζηελ 
ππνζεηηθή ιεηηνπξγία. Eίλαη θπξίσο ε δεκηνπξγία θαη εμεξεχλεζε λέσλ ηδεψλ. 
Γηαθξίλεηαη απφ ηελ ελλνηνινγηθή ηέρλε φπνπ ζρεηίδεηαη κε ηε ιεηηνπξγία θαη απφ ην 
ζρεδηαζκφ, ρσξίο σζηφζν ε ηδέα λα είλαη πξαγκαηηθά ιεηηνπξγηθή, αιιά απεηθνλίδεη έλα 
ζρέδην ην νπνίν κπνξεί λα δείμεη κηα ηδέα πνπ κπνξεί δπλεηηθά λα είλαη ιεηηνπξγηθή. 
Conceptual Design είλαη έλα ππνζχλνιν ηεο έλλνηαο ηέρλεο, φπνπ κηα λέα ηδέα ή έλα 
λέν πξντφλ έρεη δεκηνπξγεζεί απφ κία νπηηθή ηξηζδηάζηαηε αλαπαξάζηαζε, ηα νπνία ζα 
κπνξνχλ άκεζα λα ρξεζηκνπνηεζνχλ ζε έλα ηειηθφ πξντφλ, π. ρ. ζε κηα ηαηλία, 
θηλνχκελα ζρέδηα θαη βίληεν. Μπνξεί λα νξηζηεί κε δηάθνξνπο ηξφπνπο, "Έλα θίλεκα ζην 
νπνίν ε έλλνηα ή ε ηδέα πνπ εθθξάδεηαη είλαη πην ζεκαληηθή απφ ηελ απιή ιεηηνπξγία".   
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2. ΢ύζηημα AUTODESK ALIAS Interface & Βαζικέρ 
λειηοςπγίερ 
2.1. Γνωπιμία 
 
Τν Autodesk ALIAS 2011 είλαη έλα πξφγξακκα ηξηζδηάζηαηεο ςεθηαθήο 
κνληεινπνίεζεο, ην νπνίν ζηεξίδεη ηε δηαδηθαζία ηνπ δεκηνπξγηθνχ ζρεδηαζκνχ κε κηα 
κεγάιε πνηθηιία απφ εξγαιεία θαηλνηφκνπ ζρεδηαζκνχ, κνληεινπνίεζεο, επεμεξγαζίαο 
επηθάλεηαο θαη θσηνξεαιηζκνχ, πνπ βνεζνχλ ην ρξήζηε λα επηηχρεη έλα ξεαιηζηηθφ 
απνηέιεζκα. 
Τν ALIAS ππνζηεξίδεη ηελ νπηηθή αιιειεπίδξαζε κε ην πξσηφηππν (concept visual 
communication), ηε ζρεδηαζηηθή κνληεινπνίεζε (design modeling), ηελ επεμεξγαζία 
ησλ επηθαλεηψλ (technical surfacing), ηελ αληίζηξνθε κεραληθή (reverse engineering), 
ηε ζρεδηαζηηθή νπηηθνπνίεζε ζε πξαγκαηηθφ ρξφλν (real-time design visualization), ηε 
ζπλεξγαζία κε θαηαζθεπαζηηθή πινπνίεζε (engineering development collaboration) 
θαζψο θαη ηελ ελαιιαγή δεδνκέλσλ απφ θαη πξνο άιια CAD πξνγξάκκαηα φπσο 
Pro/Engineer, CATIA, 3Ds MAX θ.α. 
 
Παξέρεη: 

 Δξγαιεία ζηνπο βηνκεραληθνχο ζρεδηαζηέο γηα λα αλαπηχμνπλ ηξηζδηάζηαηα 
ζρέδηα πξντφλησλ θαη λα αιιειεπηδξάζνπλ κε απηά απφ ηελ αξρηθή ηδέα κέρξη ηηο 
ηειηθέο επηθάλεηεο. 

 Δμειηγκέλεο δπλαηφηεηεο επεμεξγαζίαο επηθαλεηψλ γηα θηλίξηζκα ησλ κνληέισλ 
θαη ησλ ζθαλαξηζκέλσλ δεδνκέλσλ, δεκηνπξγψληαο επηθάλεηεο πςειψλ 
πξνδηαγξαθψλ γηα βηνκεραληθή παξαγσγή θαη θαηαζθεπαζηηθά ζρέδηα 
απηνθηλήησλ. 

 Δμεηδηθεπκέλα εξγαιεία ηξηζδηάζηαηεο απεηθφληζεο, αλάιπζεο θαη 
θσηνξεαιηζκνχ πνπ ην ηνπνζεηνχλ ζηηο πξψηεο ζέζεηο ησλ πξνηηκήζεσλ ησλ 
ζρεδηαζηψλ απηνθηλεηνβηνκεραληψλ. 
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Δπιζκόπηζη-interface

 
 

Windows-Πεπιβάλλον διεπαθήρ 
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Πλοήγηζη ζε παπάθςπα 
 
Φξεζηκνπνηψληαο ηα πιήθηξα ηξνπνπνίεζεο ηνπ πιεθηξνινγίνπ ζε ζπλδπαζκφ κε ην 
πιήθηξν ηνπ πνληηθηνχ (θιηθ), καο επηηξέπεη λα αιιειεπηδξάζνπκε κε ην Alias κε 
απίζηεπηε ηαρχηεηα. Τα Shift, Ctrl θαη Alt (Windows) ή Shift, Control, θαη Command 
(Mac) απνηεινχλ ζεκαληηθά ζηνηρεία ηνπ πεξηβάιινληνο θαη κπνξεί λα επηηαρχλεη ηελ 
ηθαλφηεηά ζαο λα αιιάμεηε κεηαμχ ησλ θνηλψλ ιεηηνπξγηψλ ρσξίο πνηέ λα ράζνπκε ηελ 
εζηίαζή καο.  
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2.2 Απσέρ μονηελοποίηζηρ 
 
NURBS 

Τν Alias είλαη έλα NURBS (Non-
Uniform Rational B-Splines) επηθάλεηαο 
κνληεινπνίεζεο. Μαζαίλνληαο ην 
κνληέιν κε ηε γεσκεηξία NURBS είλαη 
ζαλ λα καζαίλεηο ην κνληέιν κε 
νπνηνδήπνηε θπζηθφ ή ςεθηαθφ κέζν. 
Θα πξέπεη λα θαηαλνήζνπκε ην πιηθφ 
ζπκπεξηθέξεηαη θαη πψο λα ρεηξηζηνχλ 
απηφ γηα λα επηηεπρζεί ην επηζπκεηφ 
ζρήκα. 
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Curves- Καμπύλερ 

Οη θακπχιεο δηαδξακαηίδνπλ 
βαζηθφ ξφιν ζηε δηακφξθσζε 
ζην Alias. Οη θακπχιεο 
ρξεζηκνπνηνχληαη γηα λα 
θαζνξίζνπλ ηα ζρήκαηα θαη 
πξνθίι ηνπο πνπ είλαη ε βάζε 
γηα ηε δεκηνπξγία επηθάλεηαο. 
Γηα ην ιφγν απηφ, είλαη 
ζεκαληηθφ λα δεκηνπξγεζνχλ 
θαιήο πνηφηεηαο θακπχιεο. 

 
 
 

Surfaces-Δπιθάνεια 

Ζ κνληεινπνίεζε κε NURBS γεσκεηξία απαηηεί ιίγε ζηξαηεγηθή. Τα εξγαιεία 
επηθάλεηαο καο βνεζνχλ λα δεκηνπξγνχκε επηθάλεηεο, αιιά δελ κπνξεί λα πξνβιέςεη 
νχηε ην είδνο ηνπ αληηθεηκέλνπ πνπ δεκηνπξγνχκε νχηε ηνλ ζθνπφ ηνπ κνληέινπ (είηε 
πξφθεηηαη γηα ελα πξφρεηξν κνληέιν ή γηα ηελ παξαγσγή). Αθνχ γίλεη εμνηθείσζε κε ηηο 
δηάθνξεο ηερληθέο κνληεινπνίεζεο, ζα είκαζηε ζε ζέζε λα θαζνξίζνπκε ηνλ θαιχηεξν 
ηξφπν επίηεπμεο ηνπ ζηφρνπ καο. 
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Modeling Approaches-Μονηέλα Πποζέγγιζηρ 

Οη θακπχιεο κπνξνχλ λα ρξεζηκνπνηεζνχλ γηα ηελ δεκηνπξγία επηθαλεηψλ. 
Γεκηνπξγήζηε κηα επηθάλεηαζε πνιιαπιέο θακπχιεο. Σπκπιεξψζηε ηα φξηα πνπ 
νξίδνληαη ζπλδένληαο θακπχιεο. 
 
 

 
 
 
 
 
 
 
 
 
 
 
 
Πξσηνγελήο επηθάλεηεο κπνξνχλ λα αλακηρζνχλ κε 
δεπηεξεχνπζεο επηθάλεηεο (επίζεο γλσζηή σο κεηάβαζε ζε 
επηθάλεηεο). Σε Alias, νη κεηαβάζεηο κπνξνχλ λα 
δεκηνπξγεζνχλ κε εξγαιεία επηθάλεηαο, θαζψο θαη  
εξγαιεία φπσο fill θαη blend. 
 
 
 
 

 
 

Δπηθάλεηεο νπνηνπδήπνηε ζρήκαηνο κπνξoνχλ λα 
θηηαρηνχλ ηξνπνπνηψληαο ππάξρνπζεο επηθάλεηεο. Έλα 
ζχλνιν ησλ αληηζηαζκηζηηθψλ εξγαιείσλ ζαο επηηξέπεη 
λα πεξηθφςεηαη επηθάλεηεο ρξεζηκνπνηψληαο άιιεο 
επηθάλεηεο ή θακπχιεο γηα λα θαζνξίζεη ηηο παξακέηξνπο 
θνπήο. 
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2.3 Visualization- Οπηικοποίηζη 
 
Shaders- ΢κίαζη 
επιθανειών 
 
Shaders είλαη πεξηγξαθέο ησλ 
επηθαλεηαθψλ πιηθψλ ή ησλ 
απνηειεζκάησλ πνπ 
ειέγρνπλ φ, ηη κηα επηθάλεηα 
κνηάδεη. Δίλαη αλαγθαίεο γηα ην 
πιηθφ, θαζψο θαη γηα ηελ απφδνζε 
ηεο πθήο ηεο επηθάλεηαο. 
Μπνξνχκε λα δηαρεηξηζηνχκε ηα 
shaders απφ Render > Multi-lister 
> List All θαη απφ ηε ιεηηνπξγία 
Visualization ηνπ πίλαθα ειέγρνπ. 
Τν Multi-Lister πεξηιακβάλεη ηηο 
ξπζκίζεηο γηα φια ηα shaders, ην 
πεξηβάιινλ, θαη φια ηα θψηα ζηε 
ζθελή ζαο. Κάλνληαο δηπιφ θιηθ 
ζε νπνηνδήπνηε απφ ηα ζηνηρεία 
ζην Multi-Lister αλνίγεη ε ζρεηηθή 
θαξηέια. Απφ εθέη, κπνξνχκε λα 
πξνζαξκφζνπκε ηηο ξπζκίζεηο γηα 
λα επηηχρνπλ ην πιηθφ ή ην 
απνηέιεζκα πνπ ςάρλνπκε. 
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Rendering 

 
Δθηφο απφ ηε δηαδξαζηηθή απφδνζε, ηα πεξηζζφηεξα πξντφληα Alias έρνπλ εξγαιεία 
πνπ παξάγνπλ απνηειέζκαηα θαη απνδφζεηο. Απηά βξίζθνληαη ζην κελνχ Render θαη 
πεξηιακβάλεη φιεο ηηο θαζνιηθέο ξπζκίζεηο γηα ηελ παξαγσγή render, ζπληάθηεο, θαη ηελ 
απφδνζε ραξαθηεξηζηηθψλ. Ζ απεηθφληζε ινγηζκηθνχ παξέρεη δηαθνξεηηθά 
ραξαθηεξηζηηθά θαη ηηο πξφζζεηεο ιεπηνκέξεηεο γηα ηε δεκηνπξγία εηθφλαο πνπ δελ 
κπνξνχζε λα επηηεπρζεί κε ηε Σθίαζε. Υπάξρνπλ ηξεηο κέζνδνη rendering: Raycasting, 
Raytracing, θαη Hidden Line Rendering. 
 

Raycasting 
 
Παξάγεη νκαιή ζθίαζε απεηθνλίζεηο πνπ πεξηιακβάλνπλ βαζηθέο 
ζθηέο. Ζ Raycasting είλαη ηαρχηεξε απφ φ, ηη ε  Raytracing, αιιά 
δελ παξάγεη αληα αθιάζεηο ή δηάζιαζε (αλ θαη κπνξεί λα ηα 
πξνζνκνηψζεη ρξεζηκνπνηψληαο έμππλν shaders). 
 
 
 

 
 
 

Raytracing 
 
Παξάγεη νκαιή ζθίαζε απεηθνλίζεηο πνπ πεξηιακβάλνπλ νπηηθά 
απνηειέζκαηα (αληαλαθιάζεηο θαη δηάζιαζεο) θαη ηελ νκαιή 
ζθηά. Γεκηνπξγεί πεξηζζφηεξν ξεαιηζηηθέο απεηθνλίζεηο, αιιά 
είλαη βξαδχηεξε απφ φ, ηη Raycasting. 
 
 

 
 
 
 
 

Hidden Line Rendering 
 
Παξάγεη απνδφζεηο ζην πεξίγξακκα ησλ αληηθεηκέλσλ πνπ είλαη 
γεκάηα κε επίπεδα, αζθίαζηα ρξψκα. 
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Animation 
 
Σην Alias, δεκηνπξγψληαο animation πξνυπνζέηεη ηελ εγθαζίδξπζε ελφο 
ρξνλνδηαγξάκκαηνο, ζηε ζπλέρεηα, κία ή πεξηζζφηεξεο ηδηφηεηεο ησλ αληηθεηκέλσλ (γηα 
παξάδεηγκα, ηε ζέζε ή ην ρξψκα) ζπλαξηήζεη ηνπ ρξφλνπ. Όια ηα ραξαθηεξηζηηθά ησλ 
animations είλαη ζην κελνχ Animation, ζπκπεξηιακβαλνκέλσλ ησλ εξγαιεία animation, 
ζπληάθηεο, ξπζκηζηηθφ ηνπ ρξφλνπ, θαη ηα ζηνηρεία ειέγρνπ αλαπαξαγσγήο. Όια ηα 
θηλνχκελα ζρέδηα εμφδνπ αθνινπζνχλ κηα ζεηξά απφ ζηαηηθέο εηθφλεο πνπ αληηζηνηρεί 
ζηνλ αξηζκφ ησλ πιαηζίσλ ζηελ timeline. Δηθφλα εμφδνπ ζην Animation>> Δπηινγέο 
αλαπαξαγσγήο απνζεθεχεη ηηο θσηνγξαθίεο ηεο νζφλεο αλάινγα κε ην πνηα νζφλε 
είλαη ελεξγή ζην πεξηβάιινλ Alias. Απηφ ην εξγαιείν κπνξεί λα ρξεζηκνπνηεζεί γηα λα 
ζπιιάβεη κνληέια ζε wireframe ή πιηθφ ζε ζθηά. Δλεξγνπνηψ ηελ επηινγή animation ζην 
Render> Globals Render ζέησ Alias γηα λα δεκηνπξγήζσ έλα ινγηζκηθφ πνπ παξέρεη 
αιιεινπρία ησλ εηθφλσλ, φηαλ ην επφκελν render μεθηλά. 
 
 

 
Animation> Keyframe είλαη ε θχξηα κέζνδνο γηα ηε δεκηνπξγία animation.  
Animation > Δξγαιεία> Set Motion είλαη κηα άιιε κέζνδνο, θαιή γηα 
θηλνχκελα αληηθείκελα θαηά κήθνο ζε κνλνπάηηα. 
 
 
 
Αnimation> Turntable(πεξηζηξεθφκελε βάζε) δεκηνπξγεί απηφκαηα έλα 
animation πεξηζηξεθφκελε βάζε γηα ζαο κε βάζε ηνλ αξηζκφ ησλ 
πιαηζίσλ πνπ ζέιεηε γηα κία κφλν πεξηζηξνθή. 
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Hot Keys 
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2.4 Kαηανόηζη ηων επγαλείων 
 
2.4.1 Σοποθεζία Καμπςλών & Δπιθανειών  

 
 
 
Δξγαιεία 
δεκηνπξγίαο 
θακππιψλ. 
 
 
 
 
 
Δξγαιεία 
επεμεξγαζίαο 
θακππιψλ. 
 
 
Δξγαιεία 
επεμεξγαζίαο 
θακππιψλ θαη 
επηθαλεηψλ. 
 
 
 
 
Δξγαιεία 
δεκηνπξγίαο 
επηθαλεηψλ. 
 
 
 
 
 
 
Δξγαιεία 
επεμεξγαζίαο 
επηθαλεηψλ. 
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2.4.2 Δπγαλεία δημιοςπγίαρ καμπςλών 
 

 
 
NURBS - Δίλαη ην πην 
δηαδεδνκέλν είδνο 
θακπχιεο ζην Alias. 
Πεξηγξάθεηαη σο κηα 
θακπχιε ειεχζεξεο 
ζρεδίαζεο.  
 
 
 
 

 
 
                          New CV Curve 

Γεκηνπξγεί λέεο θακπχιεο NURBS κε ηελ ηνπνζέηεζε CVs(ζεκεία). 
Μπνξνχλ λα παξαρζνχλ θακπχιεο  1, 2, 3, 5 ή 7 βαζκνχ. Ζ πξνεπηιεγκέλε 
ηηκή είλαη 3. Απφ πξνεπηινγή ε θακπχιε αξρίδεη λα εκθαλίδεηαη κεηά ησλ 
ειάρηζην αξηζκφ ησλ CVs πνπ έρεη νξηζηεί.  
 

New Edit Point Curve  
Γεκηνπξγεί λέεο θακπχιεο NURBS ζηε ζθελή κε ηελ ηνπνζέηεζε ζεκείσλ 
επεμεξγαζίαο. Μπνξνχλ λα παξαρζνχλ θακπχιεο  1, 2, 3, 5 ή 7 βαζκνχ. Ζ 
πξνεπηιεγκέλε ηηκή είλαη 3. 
 

Circle  
Γεκηνπξγεί κία NURBS θακπχιε κε ηε κνξθή ελφο επίπεδνπ θχθιν. Ζ 
δηάκεηξνο ηνπ θχθινπ νδεγείηαη απφ ηελ θιίκαθα ηνπ αληηθεηκέλνπ. 

 
 

 
 
2.4.3 Δπεξεπγαζία καμπςλών 
 

Add Points                                                                                                                                                                               
Μαο επηηξέπεη λα πξνζζέζνπκε ζεκεία ειέγρνπ (CVs) ζην ηέινο κηαο 
ππάξρνπζαο θακπχιεο, ζαλ λα ήηαλ αθφκα ελεξγή ρξεζηκνπνηψληαο ηα 
λέα εξγαιεία θακπχιεο. 
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Project Tangent  
Δπηηξέπεη ηελ ηξνπνπνίεζε ελφο άθξνπ θακπχιε ή επηθάλεηαο γηα ηελ 
επίηεπμε ηεο ζπλέρεηαο ηεο θακππιφηεηαο κε κηα επηθάλεηα. 
 

 
 

Attach 
Δλψλεη θακπχιεο ζπλδένληαο άθξα ηνπο, ελψλεη επηθάλεηεο ζπλδένληαο ηηο 
Αθκέο ηνπο ή θιείλεη κία επηθάλεηα ζπλδένληαο ηηο αληίζεηεο άθξεο ηνπ. 
 

 
 

Detach 
Φσξίδεη κηα θακπχιε ή επηθάλεηα ζε δχν ή πεξηζζφηεξα αληηθείκελα ζε 
νπνηνδήπνηε ζεκείν. 

 
 
 
 
2.4.4 Δπγαλεία δημιοςπγίαρ επιθανειών 

 
Set Planar  
Γεκηνπξγεί κία απνθνκκέλε NURBS επηθάλεηα απφ έλα ζχλνιν επίπεδσλ 
θακππιψλ ζηηο πιεπξέο ηεο. 

 
 
Revolve 
Γεκηνπξγεί κηα λέα επηθάλεηα πεξηζηξέθνληαο κηα θακπχιε γχξσ απφ έλαλ 
άμνλα, δεκηνπξγψληαο έλα απνηέιεζκα παξφκνηα κε εθείλν ελφο ηφξλνπ. 

 
 

Skin 
Μαο επηηξέπεη λα δεκηνπξγήζνπκε κηα επηθάλεηα απφ ηελ "εθδνξά" κηαο 
επηθάλεηαο NURBS ζε φιε ηελ δηαηνκή ησλ θακππιψλ. 
 
 

 

Rail Surface 

Γεκηνπξγεί κία επηθάλεηα ζαξψλνληαο κία ή πεξηζζφηεξεο θακπχιεο θαηά 
κήθνο ελφο ή δχν θακπχιψλ. Δίλαη έλα απφ ηα πην ρξεζηκνπνηνχκελα 
εξγαιεία ηνπ Alias . 
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Extrude 
Γεκηνπξγεί κηα λέα επηθάλεηα κε εμψζεζε κηαο θακπχιεο θαηά κήθνο κηαο 
θακπχιεο δηαδξνκήο. Σπλήζνο ρξεζηκνπνηνχληαη γηα λα θάλνπλ 
ζσιελνεηδή αληηθείκελα κε ζπκκεηξηθέο δηαηνκέο. 

 
Surface Fillet 
Γεκηνπξγεί κία επηθάλεηα κεηάβαζεο κεηαμχ δχν νκάδσλ εθαπηφκελσλ 
επηθαλεηψλ κε ζηαζεξά κεηαβιεηή αθηίλα, κήθνο ρνξδήο ή ην κήθνο 
εθαπηνκέλεο. 
 

Round 
Γεκηνπξγεί ζηαζεξέο ή κεηαβιεηέο ζηξνγγπιεκέλεο επηθάλεηεο θαηά 
κήθνο νπνηνπδήπνηε αξηζκνχ δεπγψλ αθκψλ, κε δηαθνξεηηθέο επηινγέο 
ρεηξηζκνχ ησλ γσληψλ. Οη αξρηθέο επηθάλεηεο πξέπεη λα ηέκλνληαη 
πξηλ απφ ηε ρξήζε ηεο Round. 

 
 
 
 

2.4.5 Δπεξεπγαζία επιθανειών 
 

Project  
Γεκηνπξγεί θακπχιεο ζε επηθάλεηα απφ ηηο ππάξρνπζεο θακπχιεο θαη 
επηθάλεηεο πξνβάιινληαο θακπχιεο πάλσ ζε επηθάλεηεο κε βάζε ηελ 
επηιεγκέλε πξνβνιή κνληέισλ.  
 

Intersect 
Γεκηνπξγεί κηα θακπχιε-on-επηθάλεηα ζην ζεκείν ηνκήο ησλ δχν 
επηθαλεηψλ. 

 
 
Trim Surfase 
Πεξηθφπηεη ή ρσξίδεη επηθάλεηεο κε βάζε ηε ζέζε ηεο δηαγσγήο 
εληνπηζηήο πνπ κπνξεί λα ρξεζηκνπνηείηαη γηα λα θαζνξίζεη είηε ηελ 
απφξξηςε ή ηελ θξάηηζε ηεο επηθάλεηα. Κάλνληαο θιηθ Divide δηαηεξεί θαη 
ηηο δχν επηθάλεηεο. Πνιιαπιέο επηθάλεηεο κπνξνχλ λα θνπνχλ 

επηιέγνληαο κε ην πιήθηξν SHIFT ηηο επηθάλεηεο. 
 

Untrim  
Δπαλαθέξεη ην απνθνκκέλν ηκήκα ηεο επηθάλεηαο. 
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Shell Stitch  
Γεκηνπξγεί έλα εηδηθφ αληηθείκελν απφ κηα νκάδα επηθαλεηψλ πνπ 
νλνκάδεηαη έλα θέιπθνο. 

 
 

 
 
 
2.5 Γςναηόηηηερ 
 

΢σεδιαζηικά & Δικονογπαθικά Δπγαλεία 

 

 
 
 
Σχιιεςε θαη πινπνίεζε ηδεψλ κε ειεχζεξε ζρεδίαζε ρσξίο αιιαγή εθαξκνγήο. Τν 
ALIAS δηαζέηεη έλα εχρξεζην ζεη εξγαιείσλ ζρεδίαζεο, εηθνλνγξαθίαο θαη 
επεμεξγαζίαο εηθφλσλ (κνιχβηα, πηλέια, αεξνγξάθνπο, καξθαδφξνπο, ζβεζηήξεο θαη 
εηδηθά πηλέια πθήο θαη εθέ). Τν νινθιεξσκέλν 2Γ/3Γ πεξηβάιινλ βνεζάεη ηνπο 
ζρεδηαζηέο λα δεκηνπξγήζνπλ ζθίηζα ζε θιίκαθα πξαγκαηηθψλ δηαζηάζεσλ θαη λα 
δσγξαθίζνπλ πάλσ ζε 3Γ δεδνκέλα πνπ έρνπλ εηζαρζεί απφ άιια πξνγξάκκαηα CAD 
γηα λα εθηηκεζεί θαηά πφζν είλαη εθηθηή ε πινπνίεζε.   
 

 Γξήγνξνο ζρεδηαζκφο ζπκκεηξηθψλ αληηθεηκέλσλ θαη άκεζε αλάδξαζε κε ηηο 
αλαινγίεο.   

 Καηαζθεπή ηέιεησλ γξακκψλ, θχθισλ θαη ειιείςεσλ κε πξνβιέςηκεο ηξνρηέο. 
 Αληηγξαθή ζπκκεηξηθψλ πηλειηψλ σο πξνο ζεκείν ή άμνλα.  
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Γςναμική Μονηελοποίηζη ΢σημάηων 
 

 
 
Γξήγνξνο ρεηξηζκφο ηνπ κνληέινπ, εμεηάδνληαο απνθιίζεηο ησλ 3Γ κνξθψλ ρσξίο 
αλαθαηαζθεπή ηεο γεσκεηξίαο, ή θάλνληαο ηξνπνπνηήζεηο ζηηο ζρεδηαζηηθέο 
ιεπηνκέξεηεο ζε πξαγκαηηθφ ρξφλν. Γπλακηθή κνξθνπνίεζε αληηθεηκέλσλ κε απηά ηα 
πνιπρξεζηηθά εξγαιεία:  
  

 Γηθηπσηφ Πιέγκα (Lattice rig) – Γηακφξθσζε ηεο γεσκεηξίαο ηνπ αληηθεηκέλνπ 
θάλνληαο ρξήζε ηνπ ξπζκηδφκελνπ δηθηπψκαηνο πνπ δεκηνπξγείηαη ζηελ 
επηθάλεηα ηνπ.  Λχγηζκα (Bend) –  

 Λχγηζκα ηεο γεσκεηξίαο ρξεζηκνπνηψληαο κηα θακπχιε γηα ηνλ έιεγρν ηεο 
παξακφξθσζεο.   

 Σηξέςε (Twist) – Σπζηξνθή ηεο γεσκεηξίαο γχξσ απφ κηα γξακκή.   
 Πξνζαξκνγή (Conform) – Πξνζαξκνγή γεσκεηξίαο ζην ζρήκα θάπνηαο άιιεο 

επηθάλεηαο. 
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Δςέλικηη Μονηελοποίηζη Πποϊόνηων 
 

 
 
 
Τα επέιηθηα εξγαιεία κνληεινπνίεζεο ηνπ ALIAS βνεζνχλ ζηνλ πεηξακαηηζκφ ηδεψλ θαη 
βξίζθνπλ πξσηνπνξηαθέο ιχζεηο ζηηο ζρεδηαζηηθέο πξνθιήζεηο. Πξνζθέξνπλ γξήγνξε 
αλαδήηεζε θαη απεηθφληζε κεγάιεο πνηθηιίαο ζρεκάησλ ρξεζηκνπνηψληαο κηα ζεηξά 
ηερληθψλ 3Γ κνληεινπνίεζεο. Τν ινγηζκηθφ βηνκεραληθνχ ζρεδηαζκνχ ηνπ ALIAS 
ζπλδπάδεη γξήγνξα, επαλαιεπηηθά, βαζηζκέλα ζε θακπχιεο, εξγαιεία κνληεινπνίεζεο 
κε ηελ ηθαλφηεηα άκεζεο επέκβαζεο θαη δηακφξθσζεο 3Γ κνληέισλ.   
 

 Δχθνιε επηινγή ηεο βέιηηζηεο ηερληθήο κνληεινπνίεζεο γηα ηελ επέκβαζε ζην 
αλάγιπθν ηεο επηθάλεηαο.   

 Γξήγνξε δεκηνπξγία πνιιαπιψλ ζρεδηαζηηθψλ επαλαιήςεσλ.   
 Δπέιηθηα εξγαιεία επηηξέπνπλ ηηο αλεπαίζζεηεο, θαζψο θαη ξηδηθέο αιιαγέο κε 

ζπλνπηηθέο θηλήζεηο. 
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Ακπιβήρ Μονηελοποίηζη Δπιθανειών 
 

 
Γεκηνπξγία επηθαλεηψλ παξαγσγήο κε ηαρχηεηα θαη απφιπην έιεγρν. Δξγαιεία 
αθξηβνχο ηερληθήο επηθαλεηψλ βνεζνχλ γηα ηε δηαζθάιηζε ζεκεηαθήο ζπλέρεηαο, 
εθαπηνκεληθήο, ή ζπλέρεηαο θακππιφηεηαο (positional, tangent, or curvature continuity) 
κε ηηο πεξηβάιινπζεο επηθάλεηεο, δηακνξθψλνληαο πςειήο πνηφηεηαο επηθάλεηεο, ηηο 
νπνίεο νκάδεο κεραληθψλ επηηπγράλνπλ κε εξγαιεηνκεραλέο.  

 Τειεηνπνίεζε επηθαλεηψλ κε αλνρέο πςειήο αθξίβεηαο ρξεζηκνπνηψληαο ην 
εξγαιείν ηξνπνπνίεζεο ησλ ζεκείσλ ειέγρνπ (control vertices-CV) πνπ 
ειέγρνπλ ηελ κνξθή ησλ θακπχισλ.  

 Αθξηβήο δεκηνπξγία θηιέησλ κε ζπλέρεηα θακππιφηεηαο- G2 (G2 continuity – 
curvature continuity) αθφκα θαη απφ απνθνκκέλα κέξε επηθαλεηψλ, 
ηθαλνπνηψληαο ηηο απαηηήζεηο ησλ πςειήο πνηφηεηαο επηθαλεηψλ.  

 Αθξηβήο απνθνπή θαη ζρεκαηηζκφο λέσλ επηθαλεηψλ.  

 Γηαηήξεζε ξεηνχ ειέγρνπ θακπχισλ θαη επηθαλεηψλ κε γεσκεηξία κνλνχ 
ηκήκαηνο (Bezier) (single-span geometry), ή θακπχισλ θαη επηθαλεηψλ κε κε-
νκνηφκνξθε γεσκεηξία πνιιαπιψλ ηκεκάησλ (NURBS) (multi-span non-uniform 
rational B-spline geometry)  

 Δπθνιία ζην ζπληαίξηαζκα ησλ πιεγκάησλ κεηαμχ πνιιαπιψλ επηθαλεηψλ θαηά 
ηε δηάξθεηα ηεο εμνκάιπλζεο ησλ επηθαλεηψλ γηα ην ζρεδηαζκφ απηνθηλήησλ  
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Αξιολόγηζη Δπιθανειών 

 

 
 
Βειηηζηνπνίεζε ησλ επηθαλεηψλ κε εξγαιεία αλάιπζεο ηα νπνία παξέρνπλ ζηηγκηαία 
πνζνηηθή θαη γξαθηθή πιεξνθφξεζε πάλσ ζηελ πνηφηεηα ηεο επηθάλεηαο. 
Φξεζηκνπνηψληαο ηα εξγαιεία δπλακηθήο αμηνιφγεζεο ζην ALIAS, φπσο ε επηθαλεηαθή 
ζπλέρεηα, ε θακππιφηεηα, θαη ε ηρλνγξαθηθή αλάιπζε, επηβεβαηψλεηαη φηη ε πνηφηεηα 
ηεο επηθάλεηαο ηνπ κνληέινπ πιεξνί ηηο κεραλνινγηθέο θαη παξαγσγηθέο πξνδηαγξαθέο. 
Τν ινγηζκηθφ ηνπ ALIAS ζπληειεί ζηε δεκηνπξγία Α-ηάμεο (A-Class) επηθαλεηψλ, έηνηκεο 
πξνο παξαγσγή, κε απνηέιεζκα ηε κείσζε ησλ αλαγθψλ γηα επαλαζρεδηαζκφ απφ 
νκάδεο κεραληθψλ. 
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Τβπιδική Γεωμεηπία 
 

 
 
Τν ινγηζκηθφ ηνπ ALIAS επηηξέπεη ηε ζπλχπαξμε ησλ πνιπγσληθψλ επηθαλεηψλ θαη ησλ 
επηθαλεηψλ NURBS ζην ίδην πεξηβάιινλ κνληεινπνίεζεο. Τξνπνπνηψληαο ηηο NURBS 
επηθάλεηεο, ελψ ην ππφινηπν πνιπγσληθφ ζρέδην δηαηεξείηαη, κπνξεί λα θεξδίζεη ρξφλν 
φηαλ ππάξρνπλ αιιαγέο πνπ επεξεάδνπλ κφλν έλα κέξνο ηνπ κνληέινπ. Τν ALIAS έρεη 
ηε δπλαηφηεηα κεηαηξνπήο ησλ δεδνκέλσλ ησλ ΝURBS ζε δεδνκέλα ζάξσζεο( 
κεηαηξνπή ησλ NURBS ζε πνιπγσληθά πιέγκαηα – meshes), κεδελίδνληαο ηελ αλάγθε 
επαλαδηακφξθσζεο νιφθιεξνπ ηνπ κνληέινπ. Ζ αμηνιφγεζε θαη ηειεηνπνίεζε ηνπ 
ηειηθνχ πβξηδηθνχ κνληέινπ, ζπλνιηθά εμνηθνλνκεί ρξφλν θαη πξνζπάζεηα. 
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Γιαδπαζηική Απεικόνιζη Μονηέλος 
 

 
 
Πξαγκαηνπνίεζε ησλ ηδεψλ κε θσηνξεαιηζηηθά πξφηππα γηα εθηχπσζε, βίληεν, ή 
δηαδξαζηηθέο παξνπζηάζεηο. Ο έηνηκνο θσηηζκφο πνπ παξέρεηαη απφ ηηο εηθφλεο θφληνπ 
ρξεζηκνπνηεί κηα απεηθφληζε κεγάινπ δπλακηθνχ εχξνπο (high dynamic range imaging - 
HDRI) σο πεγή θσηηζκνχ γηα δηαδξαζηηθή απεηθφληζε θαη απφδνζε ηνπ κνληέινπ. Τν 
απνηέιεζκα είλαη εηθφλα πςειήο αλάιπζεο γηα εθηίκεζε, παξνπζίαζε, θαη πξνψζεζε 
ησλ ζρεδίσλ ησλ πξντφλησλ. Ζ “ηζηνξία” ηνπ ζρεδηαζκνχ ηνπ κνληέινπ ζε ζπλαθή 
γεσκεηξηθά πεξηβάιινληα πνπ δεκηνπξγνχλ ξεαιηζηηθά ζθεληθά.  
 

 Φξήζε ζθίαζεο γηα αχμεζε ηνπ ξεαιηζκνχ θαη επθξίλεηα ζηελ αμηνιφγεζε 
επηθαλεηψλ θαη ζρεδηαζηηθψλ κνξθψλ.  

 Βειηηζηνπνίεζε ζθίαζεο βάζεη θαηεπζπλφκελσλ θσηεηλψλ πεγψλ γηα δεκηνπξγία 
ζθηψλ θαη αλεπαίζζεηεο ζθίαζεο.  

 Δθαξκνγή ρξψκαηνο πιηθνχ, πθήο, ιάκςεο, θσηνβνιίαο, αληαλάθιαζεο θαη 
δηάζιαζεο.  

 Γξήγνξε εθηίκεζε θαηάζηαζεο ηεο επηθάλεηαο κε ράξηεο θακππιφηεηαο, ξίγεο 
δέβξαο (zebra stripes) θαη γσλίεο βπζίζκαηνο.  

 Σηηγκηαία απνζήθεπζε εηθφλσλ πςειήο αλάιπζεο ζε νπνηνδήπνηε παξάζπξν 
κνληεινπνίεζεο κε ξεαιηζηηθή απφδνζε ρσξίο λα ρξεηαζηεί επέκβαζε ζηα 
ραξαθηεξηζηηθά ηνπ κνληέινπ.  



 
 

 35 

 

 Σχλζεζε εηθφλσλ πνπ απεηθνλίδνπλ πνιπγσληθά πιέγκαηα, ή πιήξσο ζθηαζκέλα 
κνληέια, γηα ηε δεκηνπξγία πεξηζηξεθφκελσλ εηθφλσλ ή δηαδξαζηηθά αξρεία 
QuickTime® VR.  

 Ζ ππνζηήξημε HDRI πξνζθέξεη επηπξφζζεην ξεαιηζκφ.  

 

 

3. Δθαπμογή 

      
3.1 Η ιδέα 
 

Ζ αξρηθή ηδέα πξνήιζε κεηά απφ παξαθνινχζεζε δηάθνξσλ κνληέισλ απηνθηλήησλ 
κεγάιεο  απηνθηλεηνβηνκεραλίαο. Παξαηήξεζα φηη ην ίδην κνληέιν ην πξνσζνχζε ζαλ 
δηαθνξεηηθφ απηνθίλεην θάλνληαο κηθξέο κεηαηξνπέο θαη αιιαγέο ζηελ εκθάληζε ηνπ 
εζσηεξηθνχ ηνπ απηνθηλήηνπ. Παξαδείγκαηνο ράξε, έλα απηνθίλεην ην νπνίν 
πξννξίδνληαλ γηα έλα θνηλφ ειηθίαο απφ 40 θαη άλσ ρξνλψλ, δειαδή θπξίσο γηα 
νηθνγέλεηα,  αιιάδνληαο ηηο απνρξψζεηο ζην ηακπιφ, θαη ζηνπο πίλαθεο θαη δείθηεο, 
φπσο ην ηαρχκεηξν, ην ζηξνθφκεηξν, ηνλ ρηιηνκεηξεηή θαη ην κεηξεηή θαπζίκσλ, ην 
κεηέηξεπαλ ζε έλα απηνθίλεην γηα έλα θνηλφ κηθξφηεξνπ εχξνπο ειηθίαο. Έηζη γελλήζεθε 
ε ηδέα ηεο αληηθαηάζηαζεο φισλ απηψλ ησλ επηθαλεηψλ κε νζφλεο νη νπνίεο, εκείο, 
αλάινγα κε ηελ δηάζεζε καο, ζα αιιάδακε ηελ απφρξσζε ηνπο δεκηνπξγψληαο έλα λέν 
εζσηεξηθφ απηνθίλεηνπ αλάινγν ηεο αξεζθείαο καο. Απην ζα επηηεπρζεί 
ρξεζηκνπνηψληαο εχθακπηεο νζφλεο (http://el.wikipedia.org/wiki/AMOLED) φπνπ ε 
δεκηνπξγία ηνπ εζσηεξηθνχ ηνπ απηνθηλήηνπ θαληάδεη απιή.  Θέινληαο λα εκβαζχλσ θαη 
λα εμειίμσ απηεο ηηο νζφλεο ζθέθηεθα ηελ κεηαηξνπή ηεο νζφλεο ζε  ρσξεηηθή νζφλε 
αθήο (Capacitive). Ζ νζφλε ζα θαιχπηεη ην θαηαθφξπθν κέξνο απ‟ ην ρεηξφθξελν κέρξη 
ηνπο αεξαγσγνχο ηνπ θιηκαηηζκνχ. Μέζσ απηήο ζα κπνξσ λα ρεηξηζησ φιεο ηηο νζφλεο 
θαη ηα ιεηηνπξγηθά ζπζηήκαηα ηνπ απηνθηλήηνπ. Σαλ ηειηθφ απνηέιεζκα είλαη λα έρσ 
έλαλ ειεθηξνληθφ ππνινγηζηή ζηηο άθξεο ησλ δαθηχισλ κνπ δίλνληαο καο ηελ 
δπλαηφηεηα πξφζβαζεο ζην δηαδίθηπν, θάηη ην νπνίν κπνξεί λα επηθέξεη ηεξάζηηεο 
αιιαγέο ζηνλ ηξφπν νδήγεζεο. Απφξξνηα απησλ ησλ αιιάγσλ ζα είλαη ε ζπλερή 
ελεκέξσζε απξφζκελσλ θαηαζηαζεσλ νπσο γηα παξαδεηγκα ηπρφλ αηπρήκαηα ή 
αιιαγε θαηξηθψλ θαηλνκέλσλ.  

 
 
 
 
 
 
 
 
 

 

http://el.wikipedia.org/wiki/AMOLED
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3.2 Γημιοςπγία ηαμπλό αςηοκινήηος 
 

 

 
 

Ζ πξψηε επηθάλεηα πνπ ζρεδίαζα είλαη ην ηακπιφ Τν ηακπιφ απνηειείηε απφ ηξία θχξηα 
ηκήκαηα. Τν δεμηφ ηκήκα, ην νπνίν ζα είλαη ζπκκεηξηθφ κε ην αξηζηεξφ(1,2)  θαη ην 
θεληξηθφ ηκήκα, ην νπνίν ζα θαηεβαίλεη κέρξη ηνλ κνριφ ηαρπηήησλ. Σεκαληηθφ είλαη φηη 
ην απηνθίλεην ζα είλαη ζπκκεηξηθφ σο πξνο έλα επίπεδν, θάηη ην νπνίν ζα δηεπθνιχλεη 
πνιχ ηελ εξγαζία ζρεδίαζεο. 
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Σρεδηάδσ ηέζζεξηο 
θακπχιεο ζην TOP 
view φπσο 
αθξηβψο. Έπεηηα ζε 
κηα πιάγηα φςε, 
αιιάδνληαο ζέζε 
ζηα ζεκεία έιεγρνπ 
(CVs), δίλσ ζηηο 
θακπχιεο κνπ θαη 
ηελ πιάγηα κνξθή 

πνπ ζέισ. Με ην 
εξγαιείν Rail 
Surface γηα δπν 
Generation curves 
θαη δχν Rail curves 
δεκηνπξγψ ηελ 
επηθάλεηα.  
 

 

 
Απφ ην Menu>Edit>Duplicate>Mirror δεκηνπξγψ θαη ην ζπκκεηξηθφ ηνπ ηκήκα. Δπηιέγσ 
κία απφ ηηο δπν θακπχιεο θαη κε ηελ εληνιή Duplicate curve θαη έπεηηα κε ηελ εληνιή 
Move ηελ κεηαθηλψ γηα X=0 (πάλσ ζην επίπεδν ζπκκεηξίαο). Δλψλνληαο ηηο δπν 
θακπχιεο κε δπν λέεο θαη κε ηελ ρξήζε ηεο Rail Surface γηα δπν Generation curves θαη 

δχν Rail curves δεκηνπξγψ ην κηζφ ηκήκα ηνπ θεληξηθνχ κνπ ηακπινχ. Σρεκαηίδσ έλα 
νξζνγψλην ζην χςνο πνπ ζέισ γηα λα δεκηνπξγήζσ ηνπο αεξαγσγνχο. Με ηελ 
πξνβνιή ηνπ πάλσ ζηελ θεληξηθή επηθάλεηα (Κ.Δ) (Project curve on surface) θαη έπεηηα 
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ηελ αθαίξεζε ηνπ (Trim) δεκηνπξγψ κηα νπή. Απφ ην Menu>Edit>Duplicate>Mirror 
δεκηνπξγψ θαη ην ζπκκεηξηθφ ηνπ ηκήκα. Σην ζεκείν ηνκήο ηεο Κ.Δ κε ηελ θακπχιε 

δεκηνπξγψ κία πιεπξά θαη κηζή 
βάζε ηξηγψλνπ γηα λα 
δεκηνπξγήζσ ηνλ ελεξγνπνηεηή 
ησλ Alarm. Με ηελ Duplicate θαη 
Move ηηο κεηαθηλψ ψζηε λα 
δψζσ φγθν ζην θνπκπί κνπ. 
Δπίζεο κε ηελ ρξήζε ηνπ Pivot 
ζην ζεκείν πνπ ελψλνληαη νη 
δπν πιεπξέο ηνπ ηξηγψλνπ θαη 

ηελ Scale θνληαίλσ ηηο πιεπξέο 
θάλνληαο ην πην θσληθφ. 
Κάλνληαο ρξήζε ηεο εληνιήο 
Skin δεκηνπξγψ ηηο ηξηο 
πιεπξέο ηνπ θαη έπεηηα 
επηιέγνληαο απηέο ηηο 
επηθάλεηεο κε ηελ εληνιή Mirror 
δεκηνπξγψ νιφθιεξν ην 
θνπκπί. Με ρξήζε ησλ εληνιψλ 
Round θάλσ ζηξνγγίιεκα ησλ 
αθκψλ. Τέινο, κε ηελ εληνιή 
Curve on Surface δεκηνπξγψ 
δχν λέα ηξίγσλα ηα νπνία ζα ηα 
ρξεζηκνπνηήζσ γηα ησλ 
ζρεκαηηζκφ ηνπ ιεπθνχ 
ηξηγψλνπ πάλσ ζην θνπκπί 
θάλνληαο ρξήζε ησλ εληνιψλ 
Project, Trim θαη επεηηα Skin. 
Γηα λα δεκηνπξγήζσ ην 
αζεκέλην πιαίζην πνπ 
αθνινπζεί ηελ νζφλε κνπ θαηά 
χςνο ρξεζηκνπνηψ ηελ Rail 
Surface γηα κηα Generation 
curves θαη κηα Rail curves. 
Πξνβάιινληαο ζε απηέο ηηο 
επηθάλεηεο έλα νξζνγψλην θαη 
έπεηηα ε δεκηνπξγία λέαο 
επηθάλεηαο κε ηελ ρξήζε ησλ 
θακππιψλ πνπ έρνπλ 
πξνβιεζεί ζα καο θέξεη σο 
απνηέιεζκα ην άλσ θαη θάησ 
αζεκέλην πιαίζην ησλ 
αεξαγσγψλ. Με ηνλ ίδην ηξφπν 
δεκηνπξγνχκε θαη ηα θηλεηά 
πηεξχγηα ησλ αεξαγσγψλ. Γηα 
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ηελ θαηαζθεπή ηνπ ηκήκαηνο πνπ εμέρεη απ ην ηακπιφ (φξγαλα έλδεημεο ηαρχηεηαο) 
θηηάρλνπκε κηα θακπχιε ζην χςνο θαη ην ζρήκα πνπ ζέινπκε. Έπεηηα, ζε TOP view κηα 
θακπχιε γηα λα ηελ πξνβάισ πάλσ ζην ηακπιφ κνπ. Με απηέο ηηο θακπχιεο, 
ρξεζηκνπνηψληαο ηελ εληνιή Skin δεκηνπξγψ ηελ επηθάλεηα κνπ. 

  
 
Τελ πξψηε θακπχιε (θαηζαξή) κε ηελ εληνιή 
Duplicate, αθνχ ηελ δηπιαζηάζσ, κε Scale ηελ 
κηθξαίλσ θαη ηελ κεηαθηλψ πξνο ηα θάησ θαη 
έπεηηα, κε ηνλ ίδην ηξφπν θηηάρλσ άιιε κηα 
ζηελ νπνία, κε ηελ εληνιή Rotate θαη Pivot ζε 
έλα απφ ηα άθξα ηεο θακπχιεο ηελ 
πεξηζηξέθσ θαη ηέινο κε Skin γηα ηηο ηέζζεξνηο  
θακπχιεο έρσ ην παξαθάησ απνηέιεζκα. (Ζ 
επηινγή θαη ησλ 4 θακππιψλ γίλεηαη κε Shift). 
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Γηα λα ηνπνζεηήζνπκε κηα εηθφλα ζε κηα επηθάλεηα εξγαδφκαζηε σο εμήο. Απ΄ 
ην Menu>Render>Multi-lister>Shaders... αλνίγσ ην παξάζπξν Shaders. 
Edit>New Shader γηα λα δεκηνπξγήζσ λέα. Παηψ ην βειάθη ζηε λέα Shader 
(αλνίγεη δίπια έλα ηεηξάγσλν ην νπνίν είλαη ε εηθφλα πνπ θαιχπηεη ηελ 
επηθάλεηα ηεο ζθαίξαο). Με δηπιφ θιηθ πάλσ ζηελ εηθφλα θαη Browse ζην λέν 
παξάζπξν, επηιέγσ ηελ εηθφλα (Ξχιηλε επηθάλεηα). Έπεηηα επηιέγνπκε ηελ 
επηθάλεηα πνπ ζέινπκε λα θαιχςνπκε (Τακπιφ) θαη παηάσ Shading. Με 
απηφλ ηνλ ηξφπν κεηαηξέπνπκε ην ηακπιφ καο θαη έρνπκε ηα παξαθάησ 
απνηειέζκαηα. 
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Γηα ηνπο πιατλνχο αεξαγσγνχο, 
πεγαίλσ ζην ζεκείν ην νπνίν ζέισ λα 
θηηάμσ θαη κε νθηφ θακπχιεο 
δεκηνπξγψ ην πεξίγξακκα Έπεηηα ηεα 
ην πξνβάισ ζηελ επηθαλεηα. Με ηελ 
εληνιή Pick Curve-on-Surface επηιέγσ 
θαη ηηο νθηψ θακπχιεο ζηελ επηθάλεηα 
θαη ηηο δηπιαζηάδσ.  Σηε ζπλερεηα ζα δεκηνπξγήζσ ηελ νπή κε ηελ εληνιή Trim. 
Δπηιέγσ ηηο θακπχιεο πνπ πξνεγνπκέλσο δηπιαζίαζα (θακπχιεο πάλσ ζην ηακπιφ) 
θαη ηηο μαλά δηπιαζηάδσ. Τν έλα δεχγνο ην κεηαθηλψ πξνο ην εζσηεξηθφ ηνπ ηακπινχ θαη 
ην άιιν κε Scale θαη Pivot ην κεγαιψλσ. Έηζη έρνπκε ηξία δεχγε κε θακπχιεο πνπ ζα 
κνπ δεκηνπξγήζνπλ κε ηελ εληνιή Skin ην αζεκέλην ηκήκα θαη ην ηκήκα πνπ εηζρσξεί 
ζην ηακπιφ. Πεξηζηξέθνληαο ην θαηά 90 κνίξεο, δεκηνπξγψ ηηο ηνκέο ησλ θηλεηψλ 
πηεξπγίσλ, ηα νπνία ζα πξνβάισ ζηηο επηθάλεηεο πνπ εηζρσξνχλ ζην ηακπιφ κνπ θαη 
έπεηηα κε Skin  θαη Shader ηα κεηαηξέπσ ζε πηεξχγηα. 
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3.3 Γημιοςπγία καθίζμαηορ αςηοκινήηος 
 

 
 
Γηα ηελ δεκηνπξγία ηνπ θαζίζκαηνο μεθηλάκε απφ ηελ βάζε ηεο. Αξρηθά ζρεδηάδνπκε ηελ 
βάζε, πάλσ ζηελ νπνία ηνπνζεηείηε ην θάζηζκα, ε νπνία ζα νιηζζαίλεη ψζηε λα 
κεηαθηλνχκε ην θάζηζκα εκπξφο θαη πίζσ. Σρεδηάδνπκε, ζε πιάγηα φςε, ηελ βάζε. 
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Έπεηηα κε ηελ εληνιή Duplicate δηπιαζηάδνπκε ηηο δχν θακπχιεο καο θαη ηηο κεηαθηλψ 
δεκηνπξγψληαο ηελ πξψηε βάζε. Τέινο κε ηελ εληνιή Duplicate γηα ηελ κηα βάζε 
δεκηνπξγψ θαη ηελ δεχηεξε γηα ην έλα θάζηζκα. 
 

 
Τέινο, κε ηελ εληνιή skin θαη επηιεγκέλν ρξψκα έλα κεηαιιηθφ, δεκηνπξγψ εληέιεη ηελ 
βάζε κνπ. 
 

 
Με ηνλ ίδην ηξφπν δεκηνπξγψ ηηο ξάγεο, πάλσ ζηηο νπνίεο ζα νιηζζαίλεη ε βάζε ηνπ 
θαζίζκαηνο. 
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Πάλσ ζηελ βάζε πνπ δεκηνπξγήζακε ζα ηνπνζεηήζνπκε ην θάζηζκά καο. Αξρηθά 
δεκηνπξγψ ζηελ πιάγηα φςε ην ζρέδην ηνπ θαζίζκαηνο.  
 

 
 
Μεηαθηλψληαο θαηάιιεια ηηο θακπχιεο απηέο κε ρξήζε ηεο εληνιήο Move θαη Scale ζε 
ζπλδπαζκφ κε Pivot έρνπκε ηα εμήο απνηειέζκαηα. Έπεηηα ελψλνπκε ηηο θακπχιεο 
απηέο, κε άιιεο θακπχιεο νη νπνίεο ζα καο βνεζήζνπλ  λα  δψζνπκε ην ζρήκα πνπ 
ζέινπκε ζην θάζηζκά καο. Με ηελ εληνιή Rail Sarface θαη επηιεγκέλν ρξψκα έλα 
θφθθηλν πθαζκάηηλν, δεκηνπξγψ ην θάησ κέξνο ηνπ θαζήζκαηνο. Με φκνην ηξφπν 
δεκηνπξγψ θαη ην αξηζηεξφ πιαίζην ηνπ θαζίζκαηνο πάλσ ζην νπνίν ζα ηνπνζεηεζνχλ 
θνπκπηά κε ηα νπνία ζα πξνζαξκφδνπκε, αλάινγα κε ηελ αξέζθεηά καο ηελ ζέζε ηνπ 
θαζίζκαηνο. 
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Σπλερίδνπκε κε ηνλ ζρεδηαζκφ ηεο πιάηεο. Σε πιάγηα φςε ζρεδηάδνπκε ηηο θακπχιεο 
πάλσ ζηηο νπνίεο ζα εθάπηνπλ νη επηθάλεηέο καο. 

 
Μεηαθηλψληαο θαηάιιεια ηηο θακπχιεο απηέο κε ρξήζε ηεο εληνιήο Move θαη Scale ζε 
ζπλδπαζκφ κε Pivot έρνπκε ηα εμήο απνηειέζκαηα. Έπεηηα ελψλνπκε ηηο θακπχιεο 
απηέο, κε άιιεο θακπχιεο νη νπνίεο ζα καο βνεζήζνπλ  λα  δψζνπκε ην ζρήκα πνπ 
ζέινπκε ζην θάζηζκά καο. Με ηελ εληνιή Rail Sarface θαη επηιεγκέλν ρξψκα έλα 
θφθθηλν πθαζκάηηλν, δεκηνπξγψ ην θάησ κέξνο ηνπ θαζήζκαηνο. 
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Τέινο, αθνχ έρνπκε δεκηνπξγήζεη ην έλα θάζηζκα κε ηελ εληνιή Duplicate θαη Move ησλ 
επηθαλεηψλ δεκηνπξγψ θαη ηα ππφινηπα ηξία θαζίζκαηα. 
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3.4 Γημιοςπγία εξωηεπικών επιθανειών αςηοκινήηος 
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Γηα ηελ δεκηνπξγία ησλ εμσηεξηθψλ επηθαλεηψλ ηνπ απηνθηλήηνπ εξγαδφκαζηε σο εμήο. 

Πάκε ζε κηα πιάγηα φςε θαη ζρεδηάδνπκε ηηο θακπχιεο - γξακκέο ηνπ απηνθηλήηνπ 

αλάινγα κε ηελ κνξθή πνπ ζέινπκε λα ηνπ δψζνπκε. Έηζη ζρεδηάδνπκε ηηο παξαθάησ 

θακπχιεο. 

 
Έπεηηα, απφ ηελ θάηνςε, κε ηελ εληνιή Move CVs δίλσ ζηηο θακπχιεο κνπ ηελ κνξθή 
πνπ ζέισ λα έρνπλ. 
 

 
Σηελ ζπλέρεηα δεκηνπξγψ ηηο θακπχιεο ηεο νξνθήο θαη ηεο θνιφλαο καδί κε ηελ 
θακπχιε ζηελ νπνία ζα ηνπνζεηεζνχλ ηα ηδάκηα. 
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Γηα λα δεκηνπξγήζνπκε ηελ ηελ πιάγηα επηθάλεηα ηνπ απηνθηλήηνπ ελψλνπκε ηηο 
θακπχιεο πνπ έρνπκε κε λέεο, ηηο νπνίεο απφ ηελ πίζσ φςε, κεηαθηλψληαο ηα CVs, 
δίλνπκε ηελ κνξθή ηεο επηθάλεηαο.  
 

 
Έπεηηα, κε ρξήζε ηεο εληνιήο Rail Surface κε Generation Curves ηηο θάζεηεο θακπχιεο, 
Rail Curves ηηο νξηδφληηεο θακπχιεο θαη κε επηιεγκέλα Implied Tan ζηελ επηινγή 
Continuity θαη ηζεθαξηζκέλα ηα Rebld έρνπκε ην απνηέιεζκα πνπ ζέινπκε. 
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Με λέα θακπχιε πνπ ελψλεη ηηο θακπχιεο γηα ηελ θνιφλα ηεο νξνθήο δεκηνπξγψ θαη ην 
ππφινηπν ηκήκα. 

 
Δπηιέγσ ηηο επηθάλεηεο θαη ηηο θακπχιεο θαη κε ηελ εληνιή Mirror(Edit>Duplicate>Mirror) 
δεκηνπξγψ ην δεμί ηκήκα ηνπ απηνθηλήηνπ. 
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Έρνληαο θαη ηα δχν ηκήκαηα, μεθηλάκε λα ηα ελψλνπκε κε θακπχιεο, ψζηε λα 
δεκηνπξγήζνπκε ην θαπφ, ηελ νξνθή θαη ην πίζσ ηκήκα. Πξνζέρνπκε ψζηε ζηα ζεκεία 
πνπ ελψλνληαη νη επηθάλεηεο καο λα είλαη νκαιέο (λα κελ δεκηνπξγνχληαη γσλίεο, 
ζπαζίκαηα). Απηφ επηηπγράλεηε κε ηελ ρξήζε ηεο εληνιήο Project Tangent ε νπνία 
κεηαθηλεί έλα ή θαη παξαπάλσ CVs. 
 

 
 

 
 
Με ρξήζε ηεο εληνιήο Rail Surface κε Generation Curves ηηο θάζεηεο θακπχιεο, Rail 
Curves ηηο νξηδφληηεο θακπχιεο θαη κε επηιεγκέλα Implied Tan ζηελ επηινγή Continuity 
θαη ηζεθαξηζκέλα ηα Rebld δεκηνπξγψ ηνλ πίζσ πξνθπιαθηήξα. Δπίζεο, κε ηελ ίδηα 
εληνιή, κε Generation Curves ηελ θακπχιε πάλσ απν ηνλ πίζσ πξνθπιαθηήξα θαη ηελ 
θακπχιε ηνπ παξκπξίδ, Rail Curves ηηο θακπχιεο ζηελ νξνθή δεκηνπξγνχκε ηελ 
νξνθή. Με ηνλ ίδην ηξφπν έρνπκε θαη ην θαπφ ηνπ απηνθηλήηνπ. 
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Γηα ηελ δεκηνπξγία ησλ νπψλ ζηα νπνία ζα ππάξρνπλ νη ηξνρνί θηηάρλνπκε ηξηο 
νκφθεληξνπο θχθινπο θαη πξνβάινπκε ηνλ κεγαιχηεξν ζηηο επηθάλεηεο ψζηε κε ηελ 
εληνιή Trim λα αθαηξέζνπκε απηφ ην ηκήκα. Πξίλ αθαηξέζσ ην ηκήκα, κε ηελ εληνιή 
Duplicate δεκηνπξγνχκε λέα θακπχιε ηελ νπνία ζα ρξεζηκνπνηήζσ ζηε ζπλέρεηα ζηελ 
εληνιή Rail Surface. Τνπο ππφινηπνπο δχν ηνπο κεηαθηλνχκε ιίγν πην έμσ απφ ηηο 
επηθάλεηεο κε ζθνπψ ηελ δεκηνπξγία λέαο επηθάλεηαο πνπ ζα πξνεμέρεη. Με ηελ εληνιή 
Detach θφβσ ηα ηκήκαηα ησλ άιισλ δχν θχθισλ πνπ δελ κπνξνχκε λα ηα πξνβάινπκε 
ζηηο επηθάλεηεο ηνπ απηνθηλήηνπ. Σρεκαηίδσ ηηο δχν θακπχιεο πνπ ζα ρξεζηκνπνηήζσ 
σο Generation Curves ζηελ εληνιή Rail Surface. Με ηνλ ίδην ηξφπν δεκηνπξγνχκε θαη 
γηα ηνλ πίζσ ηξνρφ θαη έπεηηα κε ηελ εληνιή Mirror ηα δεκηνπξγνχκε θαη απφ ηελ δεμηά 
πιεπξά. 
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4. ΢ςμπεπάζμαηα-Αξιολόγηζη 
 
   

Τν Autodesk Alias απνηειεί έλα παγθνζκίσο θαηαμησκέλν CAD πξντφλ βηνκεραληθήο 
ζρεδίαζεο. Τν Autodesk Alias είλαη έλα δπλακηθφ ινγηζκηθφ ζρεδηαζκνχ. Βνεζάεη ζηε 
δεκηνπξγηθή δηαδηθαζία ζρεδηαζκνχ κε κηα ζεηξά απφ ζρεδηαζηηθά εξγαιεία 
κνληεινπνίεζεο, επηθαλεηαθά εξγαιεία, θαη νπηηθνπνίεζεο. Γεκηνπξγεί ζρέδηα 
πξνζαξκνζκέλα γηα βηνκεραληθφ ζρεδηαζκφ, ην ζρεδηαζκφ απηνθηλήησλ θαη ηελ ηερληθή 
ησλ επηθαλεηψλ. Φαξαθηεξηζηηθά ζην Alias Autodesk απηνθηλήησλ θαη βηνκεραληθψλ 
software design  "Autodesk Design Alias, Autodesk Surface Alias θαη Autodesk Alias 
Automotive" ππνζηεξίδνπλ ηελ έλλνηα ηεο νπηηθήο επηθνηλσλίαο, ηεο κνληεινπνίεζεο 
ηνπ ζρεδηαζκνχ, ηελ ηερληθή επηθαλεηψλ, ηελ αληίζηξνθε κεραληθή, ηελ νπηηθνπνίεζε 
ζε πξαγκαηηθφ ρξφλν, ηελ αλάπηπμε θαη ηε κεραληθή ζπλεξγαζία. 
 
Μειινληηθά ζα πεξηκέλακε λα επηηεπρζεί ε ρξήζε ηνπ ίληεξλεη ζε φια ηα νρήκαηα κε 
ζθνπφ ηελ επηθνηλσλία ησλ απηνθίλεησλ κε ζηφρν ηελ απνθπγή αηπρεκάησλ. Τνλ 
θσλεηηθφ έιεγρν, ζε φζν ην δπλαηφλ πεξηζζφηεξεο γιψζζεο, γηα ηνλ εμ απνζηάζεσο 
έιεγρν ηνπ ζπζηήκαηνο. Αζχξκαηε ζχλδεζε θηλεηψλ ηειεθψλσλ κε ην ζχζηεκα ηνπ 
απηνθίλεηνπ θαη πιήξεο ζπγρξνληζκφο. Παξακεηξνπνίεζε ρξψκαηνο εμσηεξηθήο 
επηθάλεηαο  
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ΒΙΒΛΙΟΓΡΑΦΙΑ 
 
http://mosaic.autodesk.com/autodeskalias  
 
http://www.autodesk.com/products/autodesk-alias-products/overview 
 
http://www.cadcimtech.com/aliasdesign_2012/aliasdesign_2012.htm 
 
http://www.carbodydesign.com 
 
http://el.wikipedia.org 
 
Autodesk Alias 2011 Tutorials 
 
Νηθφιανο Μπηιάιεο,Δκκαλνπήι Μαξαβειάθεο, Σπζηήκαηα CAD/CAM θαη ηξηζδηάζηαηε 
κνληεινπνίεζε 
 
Νηθφιανο Μπηιάιεο, Μειέηε θαη αλάπηπμε πξντφλησλ 

http://mosaic.autodesk.com/autodeskalias
http://www.autodesk.com/products/autodesk-alias-products/overview
http://www.cadcimtech.com/aliasdesign_2012/aliasdesign_2012.htm
http://www.carbodydesign.com/
http://el.wikipedia.org/

